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Thank you for purchasing this Janome Robot. 
 
 Before using your robot, please read this manual thoroughly 

and always make sure you use the robot correctly. In 
particular, be sure to thoroughly read “For Your Safety” as it 
contains important safety information. 

 
 After reading this manual, store in a safe place that can be 

easily accessed at any time by the operator.  
 
 This manual is written according to IEC 62079. 
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PREFACE 
 

 
The Janome Desktop Robot JR3000 Series are new low-cost, high-performance robots. With these 
robots we succeeded in reducing the price while maintaining functionality. The combined use of 
stepping motors and specialized micro step driving circuits saves both energy and installation space. 
This operation manual explains how to use JR C-Points II for the JR3200, JR3300, JR3400, JR3500* 
and JR3600* series (*under development). There are several manuals pertaining to these robots as 
listed below. 
Mouse operation and the use of dialog boxes for JR C-Points II are the same as those in Microsoft 
Windows® 7/8/8.1 applications. For information about Windows® 7/8/8.1 operating methods, refer to 
the instruction manual supplied with Windows® 7/8/8.1. The information within this manual is based on 
the PC software Ver. 2.0x. Windows, Excel, Word are registered trademarks of Microsoft Corporation. 
 
JR3000 Series 

For Your Safety This is important safety information. Make sure you read this before using the 
robot. 

Setup 

Explains how to set up the robot.  
■ Make sure you read this manual ■ 
NOTE: This manual is designed for people who have received safety and 

installation training regarding the robot. 

Maintenance 

Explains maintenance procedures for the robot. 
■ Make sure you read this manual ■ 
NOTE: This manual is designed for people who have received safety and 

maintenance training regarding the robot. 

Basic Instructions Provides part names, data configurations, and the basic knowledge 
necessary to operate the robot. 

Quick Start Explains the actual operation of the robot by creating and running simple 
programs. 

Teaching Pendant 
Operation Explains how to operate the robot via the teaching pendant. 

Functions I Explains point teaching. 
Functions II Explains commands, variables, and functions. 
Functions III Explains functions such as All Program Common Settings and PLC programs. 
Functions IV Explains Customizing Functions. 
External Control I 
(IO/Fieldbus) 

Explains IO and Fieldbus. 
Please refer to this manual if you are using Fieldbus. 

Communication 
Control (COM/LAN) Explains COM 1 – 3 and LAN communication control. 

Camera & Sensor 
Functions Explains the functions of the attachable camera and Z position sensor. 

Specifications Outlines general specifications such as the robot’s operating range, mass, etc. 
Auxiliary Axis 
Functions Explains the auxiliary axis functions. 

PC Operation Explains how to use the PC software JR C-Points II. 
Application 
Specifications Explains the specialized functions of each of the application specifications. 
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Note: The content of this manual may differ from the robot in your possession due to updates to the 
product specifications. 

 
The descriptions within this manual are based on standard specifications. The menu item names etc. 
may vary depending on the model type. 
 

To make full use of the machine’s functions and capabilities, make sure that 
you use the robot according to the correct handling/operation procedures 
that are written in the manuals listed on the previous page.  

 
If you turn OFF the power after making changes to robot’s settings or data 
without saving, these changes are lost and the robot will revert to its original 
settings. Make sure that you save any changes to data and/or settings. 

 
Before using this robot for the first time, make sure you back up robot data 
and save the individual configuration information. Individual configuration 
information is needed when replacing internal circuit boards. 

 
Before transmitting C&T data to or from a PC and robot, make a back-up 
copy and save it to a PC in case of error. 

 

 
 

 

 

 

Warning 
 

Always make sure the machine is grounded through the power 
cord. Do not use the machine when it is not grounded. 
Improper grounding causes electric shocks, fires, malfunction, and 
unit breakdown. 

Make sure that the machine power supply is OFF before 
connecting the power cord.  
Failure to do so could cause electric shock and/or injury. 

Warning 
 

Do not handle or operate the robot in ways not covered in the 
manuals listed on the previous page. Contact Janome (listed on the 
back page of this manual) for repairs.  
Failure to do so can cause electric shock and/or injury. 

Warning 
 

Attention 

Attention 

Attention 

Attention 
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FOR YOUR SAFETY 
 

 
The safety notes outlined below are provided in order to ensure safe and correct usage of the product 
in addition to preventing injury to the operator, other people and damage to property as well. 
 

･････ Be sure to follow the safety guidelines detailed here ･････ 
 
Symbols are also listed alongside the safety note explanations. Please refer to the list below for an 
explanation of these symbols. 
 
 Symbols that indicate the level of danger and/or damage. 
The level of danger or damage that could occur as a result of ignoring these safety guidelines and 
misusing the robot are classified by the following symbols.  

 This symbol indicates an imminent risk of serious injury or 
death. 

 
This symbol indicates a risk of serious injury or death. 

 This symbol indicates the possibility of serious injury or damage 
to property. 

 
 The following symbols list the nature of the danger and any necessary safety methods to be taken. 

 Indicates caution must be taken 

 Take Caution  (General Precaution) 

 Indicates a forbidden action 

 Never do this  (General Precaution) 

 Do not disassemble, modify or repair. 

 Do not touch  (Contact Prohibition) 

 Indicates a required action 

 Be sure to follow instructions  (General Requirement) 

 Be sure to unplug the power supply cord 

 Make sure the machine is grounded 

  

Warning 
 

Danger 
 

Caution 
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FOR YOUR SAFETY 
 

 
If using auxiliary axis functions to operate a motor, such as a servo motor, that produces 
feedback and/or a motor with high output etc., or when using auxiliary axes in the 
formation of a robot etc., we ask that you perform a risk assessment on your side and 
take any necessary safety measures. 

 
If Using Auxiliary Axis Functions in a Way that Require Safety Measures 

 

 
 
 

Always set up a safety enclosure or cover the robot with a guard so the 
moveable parts cannot be touched. 
Anyone within the maximum reach of the robot and the auxiliary axes it is controlling 
may be injured. Using the IO-S connector accessory, set up an emergency stop 
interlock system that cuts off the motor power to the auxiliary axes and is 
triggered when the entrance to the safety enclosure is opened. Make sure there is 
no other way of entering the restricted area. 
Furthermore, put up a “No Entry” or “Do Not Operate” warning sign in a clearly 
visible place. 
 
Example: 
 
 
 
 
 
 
 
 
 
 

  

Danger 
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FOR YOUR SAFETY 
 

 
If Using Auxiliary Axis Functions in a Way that Require Safety Measures 

 

 

When power to the robot is ON, never enter the safety enclosure or put your 
face, hands, or any part of your body inside.  
Failure to do can result in injury. 

 

When entering the safety enclosure due to something wrong with the robot or a 
peripheral device, or to inspect or lubricate the machine etc., with both the power 
supply breaker and the robot switched OFF, make sure to lockout and tagout 
and confirm there is no electricity flowing to the robot. 
Failure to do so can cause electric shock or injury. 

 

 

 

When creating a robot system using auxiliary axis functions, if the system can be 
categorized as an industrial robot, operators in Japan who engage in teaching, 
inspections, adjustments and/or repairs must take lectures as part of the “special 
education” for industrial robots as stipulated by Article 59 of the Japan 
Industrial Safety and Health Act and the related regulations. 
Likewise, when using the robot outside of Japan, make sure to do so according to the 
laws and guidelines of the country where it is used. 

 

Before performing a run or operation, always check the following: 
• Obstacles: Make sure there are no obstacles or people within the 

safety enclosure. 
• Installation: Make sure the robot is installed properly, that there are 

no abnormalities with the robot and the surrounding 
devices, and that the teaching pendant and tools are in 
the appropriate places. 

• Emergency Stop Switch: Make sure the IO-S circuit (interlock) and emergency 
stop switch(s) are functioning properly. 

It is potentially dangerous to operate the robot without making these checks first. 

Warning 
 

Danger 
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FOR YOUR SAFETY 
 

 
If Using Auxiliary Axis Functions in a Way that Require Safety Measures 

 

 

Construct a safety enclosure that is strong enough to protect the operator 
against such dangers as the tool or workpiece splintering, etc. 
When working within the safety enclosure, use protective gear such as a helmet, 
protective gloves, protective goggles, and safety shoes. 
Failure to follow these safety measures can result in injury. 

 

If objects that the robot grasps have a risk of falling or being projected, take into 
account the size, weight, and chemical composition of the objects for the 
required safety precautions. 
Failure to do so can result in injury or unit breakdown. 

 

When working within the safety enclosure, make sure not to come within the 
maximum range of the robot. 
Failure to do so can cause injury. 

 

When starting a run, first confirm there are no people inside of the safety enclosure 
and there are no obstacles that could interfere with the run. 
Failure to do so can cause injury or unit breakdown. 

 
 
  

Warning 
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FOR YOUR SAFETY 
 

 

 

 

Do not use where flammable or corrosive gas is present. 
Leaked gas accumulating around the unit causes explosions and fire. 

 

 

 

Make sure that you securely install the unit in a place that can fully withstand 
both the unit’s weight and its usage. Install the robot and switchbox on a workbench 
60cm or higher above floor level, and install the robot in the center of the workbench.  
In addition, for units with a cooling fan on the back, allow for 30cm or more 
clearance between the back of the unit and the wall.   
If installation is inadequate, the unit can drop or fall over causing injury and unit 
breakdown. Also, inadequate installation causes overheating and fire. 

 

Make sure to power the unit within its rated current range. 
Failure to do so causes electric shocks, fires, and unit malfunction. 

 

Plug the power cord into the wall outlet firmly. 
Failure to do so causes the plug to heat up resulting in fire. 

 

Be sure to use the unit within its indicated voltage range. 
Failure to do so causes fires and unit malfunction. 

 

When replacing fuses, or inspecting or lubricating the unit, unplug the power 
cord from the wall outlet, then remove the cord from the main unit and make 
sure there is no electrical current. Also, do not touch any of the power inlet pins 
within 5 seconds of removing the power cord. Failure to follow these steps causes 
electric shocks and injury. 

Warning 
 

Danger 
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FOR YOUR SAFETY 
 

 

 

 

Always make sure the machine is grounded through the power cord.  
Do not use the machine when it is not grounded. 
Improper grounding causes electric shocks, fires, malfunction, and unit breakdown. 

 

Wipe the power plug with a clean, dry cloth periodically to eliminate dust. 
Dust accumulation deteriorates the electrical insulation and causes fires. 

 

Be sure to unplug the power cord from the power outlet when the unit is not in 
use for long periods of time. 
Dust accumulation causes fires. 

 

Be sure to turn OFF the unit before inserting or removing cords and cables such 
as the teaching pendant cable. 
Failure to do so causes electric shock, fire, data loss, and unit malfunction 

 

Do not attempt to disassemble or modify the unit. 
Disassembly or modification causes electric shocks and unit malfunction. 

 

Do not allow water or oil to come in contact with the unit, control box or the 
power cord. 
Contact with water or oil causes electric shock, fire, or unit malfunction.  
IP Protection Rating: IP20. 

 

If anything unusual occurs, such as a burning smell or unusual sound, stop 
operation and unplug the power cord immediately. Contact the dealer from 
whom you purchased the robot or the office listed on the last page of this 
manual. 
Continuing to use the robot without addressing the problem causes electric shock, fire, 
or unit breakdown. 

 
  

Warning 
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FOR YOUR SAFETY 
 

 

 

 

Do not drop or jar the unit during transport and/or installation. 
This causes injuries or damages the unit. 

 

Before performing any operation, ensure there is no imminent danger to any of 
the operators. Failure to do so causes injury. 

 

Use the unit in an environment between 0 and 40°C, with a humidity level of 20 – 
90%, and without condensation. 
Use outside of these conditions can cause unit malfunction. 

 

Use the unit in an environment where no electrical noise is present. 
Failure to do so causes unit malfunction or breakdown. 

 

For models with IO-S circuits, when installing the unit, take safety measures 
such as setting up area sensors and an enclosure.  
If there are no safety measures in place and someone enters the area of operation 
when the robot is running, they may be injured. 

 

Keep the emergency stop switch within reach of the operator when running or 
operating the robot. 
If the robot is operated when the emergency switch is not within reach, it may not be 
possible to stop the robot immediately and safely. This is potentially dangerous. 

 

Make sure that you regularly perform a function check for the emergency stop 
switch. Also, for models with IO-S circuits, regularly perform an IO-S circuit 
function check.  
If you perform work without making a circuit check, you or the operator will not be able 
to immediately and safely stop the robot in an emergency. This is potentially 
dangerous. 

  

Caution 
 

14 



PC Operation Desktop Robot JR3000 

FOR YOUR SAFETY 
 

 

 

 

When attaching tools etc., make sure they are securely fitted before running the 
robot.  
Failure to do so causes injury or breakdown. 

 

When using the machine for extended periods of time, check and make sure 
none of the main unit’s mounting screws are loose, and perform a routine 
inspection every 3 months. Failure to do so causes injury or breakdown. 

 

Be sure to check the connections of the cords and cables to the main unit. 
Improper wiring causes unit malfunction or breakdown. 

 

Be sure to secure the movable parts of the unit before transportation. 
Failure to do so causes injury or breakdown. 

 

When lifting and transporting the robot, do so with 2 or more people. 
Failure to do so causes injury or breakdown. 

 

Use the unit in an environment that is not exposed to direct sunlight. 
Direct sunlight causes unit malfunction or breakdown. 

 

Individual configuration information varies for each individual unit even if they are the 
same model. Do not use backup data with a different robot. The robot cannot 
function normally with backup data from a different robot.  

 
 
 
  

Caution 
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1. OPERATING ENVIRONMENT 
 

 
The following system configurations are necessary to run the software JR C-Points II or JR C-Points II 
Limited Edition (included in the operation manual CD-ROM). 
 
 
• Personal Computer 

Capable of running Windows® 7/8/8.1. 
 
• Memory Capacity 

A minimum of 512 MB of memory is required to operate JR C-Points II or JR C-Points II Limited 
Edition properly. 

 
• Operating System 

Microsoft Windows® 7/8/8.1 
NOTE: Compatible with both 32bit/64bit. 

 
• Hard Disk Capacity 

After installing Windows® 7/8/8.1 a minimum of 2 GB of open hard disk space is required. 
 
• LAN Cable (Ethernet) 

A LAN cable with the specifications below is required to connect the robot and the computer. 
- Straight cable (CAT5) 

 
• Connectable Ethernet (PC side) specifications are as follows: 

- 10/100BASE-TX - LAN Port: RJ-45 
 
The required memory capacity or hard disk space may vary depending on the system environment. 
Please note that insufficient hard disk space may lead to a memory shortage or trouble during 
operation.  
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2. INSTALLATION AND UNINSTALLATION 
 

 
To use JR C-Points II, first install the software onto a PC. 
 

NOTE 
Install the software using your PC’s administrator account. 
Do not attempt to install JR C-Points II when JR C-Points II Limited Edition is already installed. If JR 
C-Points II Limited Edition is installed, first uninstall JR C-Points II Limited Edition and then install 
JR C-Points II. 

 
2.1 Installation 
1. Start Windows® and check that it is functioning properly. Before installation, close all applications. 
2. Place the JR C-Points II CD-ROM in the CD-ROM drive. 
3. The installer will automatically start up. Follow the instructions on the screen. 

Additionally, to use JR C-Points II you need Microsoft.NET Framework 4 Client Profile and 
Microsoft.NET Framework 4 Extended software framework. When installing JR C-Points II, these 
are also installed. Agree with the User Agreement and install them. 
 
NOTE 
Microsoft.NET Framework 4 Client Profile and Microsoft.NET Framework 4 Extended are 
registered trademarks of Microsoft Corporation.  

 
Enter the Serial Number listed on the label on the back of the CD-ROM case.  
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 If the Installer Doesn’t Start up Automatically, 
1. Click on Windows® Explorer or [CD-ROM Drive] from [My Computer]. 
2. Double-click [¥SETUP.EXE] icon in the [CD-ROM Drive]. 
3. Follow the instructions on the screen. 
 

NOTE 
If you are using Windows 7, the Program Compatibility Assistant dialog may appear after you install 
JR C-Points II. If this dialog is displayed, select “This program installed correctly”.  
Additionally, this dialog may also appear after using JR C-Points II. Check “Don’t show this 
message again” to stop this dialog from appearing. 

 
 
2.2 Uninstallation 
1. Start Windows® and check that it is functioning properly. Close all open applications. 
 
2. Place the JR C-Points II CD-ROM in the CD-ROM drive. 
 
3. The installer will start up automatically. If it does not start, click on Windows® Explorer or the 

[CD-ROM Drive] icon under [My Computer]. 
 
4. Follow the instructions on the screen. Running the installer when the software is already installed 

causes uninstallation to occur. 
 

NOTE 
To upgrade the software, start up the installer to uninstall the existing application, and then start up 
the installer again to install the new software. 
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3. STARTUP AND EXIT 
 

 
3.1 Start Up 

 
You can teach off-line (while the robot is not connected to the PC or the robot is turned off) using JR 
C-Points II. 
However, in this case, communication between the robot and the PC cannot be established so the 
robot’s configuration information cannot be read. The dialog shown below is displayed. Set the robot 
model name, axes info, motor type and click [OK]. In this case, you cannot operate the robot from the 
PC.  
(If you start up JR C-Points II when your PC is connected to the robot, the robot’s configuration 
information is loaded automatically.) 

 
NOTE 

• Depending on your robot’s application specifications, the shortcut icon, and the robot series and/or 
models you can select in the model selection dialog may vary. 

• If you start up JR C-Points II while the robot is offline, the auxiliary axes’ names and the units 
displayed are not what are displayed on the robot, but are the JR C-Points II defaults.  

Shortcut Icon 

Select “Program” from the Start Menu of Windows® and select “JR C-Points II”, 
or click on the JR C-Points II shortcut icon on the desktop. 
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3.2 Exit 
You can exit JR C-Points II, using any of the following methods: 
 

 
 
  

 

• Click the  button on the upper right corner of 
the screen. 

 

• Click [Exit] on the [File] pull-down menu. 
 

• Double click  on the top left of the screen. 
 

If unsaved C & T data is open, an exit confirmation 
dialog appears. 
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4. CONNECTING THE ROBOT TO A PC 
(ETHERNET) 

 

 
4.1 Ethernet Overview 
The robot is fitted with an Ethernet connector (10/100BASE-TX) by standard. 
The LAN port is on the front of the robot. 
By using Ethernet and transmitting commands and data from a PC, you can use functions such as the 
ones below: 

 

 

 
To back up the robot’s C&T data (customizing and teaching data) and upgrade the robot’s system 
software, connect the robot to a PC and make sure they are able to interface.  
When using Ethernet, you can connect to and use multiple robots with one PC through a hub. 
If you are using JR C-Points II (optional) to operate the robot from the PC, please remove the teaching 
pendant. 
You cannot operate the robot with the teaching pendant connected. 
You cannot use a teaching pendant with an emergency stop switch (optional) unless a short connector 
is connected. 
  

LAN Port 

Robot Front 

1. Send and receive C & T data  
2. Overwrite the system program 
3. Online teaching such as JOG and GO movements etc. 
4. Monitor functions such as external I/O and Fieldbus I/O 

display etc. 
5. Online settings such as administration settings and 

teaching environment settings etc. 
6. Robot information display such as system information and 

error history etc. 
 

JR3203N-AC Example 

Caution 
If you instruct an urgent stop from a network other than IO-SYS, a 
small amount of time is needed for the robot to actually stop after the 
command is sent. 

21 



PC Operation Desktop Robot JR3000 

4.2 LAN Cable 
Use a straight cable (category 5) compatible with the 10/100BASE-TX standard to connect the robot to 
a PC. Insert one end of the LAN cable into the robot’s LAN port and one end into the PC’s LAN port. 
 

 
 

 
 
 
4.3 LAN Port 
LAN Port (Diagram RJ-45) 

 

 
 
LAN Connector (LAN) Pin Assignment 
Pin No. Name Function 

1 TD+ Transmit signal+ 
2 TD- Transmit signal- 
3 RD+ Receive signal+ 
4 NC Not connected 
5 NC Not connected 
6 RD- Receive signal- 
7 NC Not connected 
8 NC Not connected 

 
  

Attention 
Make sure the power to both the robot and the PC are OFF before attaching 
or removing the cable. Failure to do so causes malfunction. 

PC 

Straight cable 
(Category 5) 

JR3203N-AC Example 

8 1 

22 



PC Operation Desktop Robot JR3000 

5. COMMUNICATION PREPARATION 
 

 
5.1 Communication Preparation Procedure 
To communicate with the robot, set up the communication settings. 
To connect with Ethernet, you need to set up an IP address and subnet mask on the robot and register 
this IP address on the PC. 

 

 
To use the Ethernet function, you need to have TCP/IP settings complete on the PC with JR C-Points II 
installed. However, before setting up TCP/IP, please take note of the following: 
 
• To use Ethernet function, a TCP/IP network environment is required. 
• The robot uses a fixed IP address; therefore please do not use a DHCP server etc. 
 
 
5.2 Setting Up an IP Address on Your PC 
If an IP address is not set to the PC, please set one. 
The robot is not compatible with IPv6, therefore please use IPv4. 
If an IP address is already set to the PC, you do not need to set this up again. 
 

NOTE 
• Methods for setting up an IP address on a PC vary depending on your Windows® version. Please 

refer to your PC’s manual. 
• We recommend using a private IP address class C (192.168.0.0 – 192.168.255.255). However, 

you cannot set 0 or 255 to the 4th octet (the far right digits). 
• If you are setting up a new IP address to your PC, please consult your network administrator. 
 
  

Set the PC IP address Set the robot IP address 
Set up the Ethernet 
communication settings 
on the PC 
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5.3 Setting Up an IP Address on Your Robot 
By default the robot is initially set with the IP address “192.168.200.180”. You can set the robot’s IP 
address with the following procedure. Also, you can change the robot’s IP address from the teaching 
pendant. 
 
1. Select [Robot] on the menu bar and click [IP-address Setting] from the pull-down menu.  
 
2. On the robot IP-address settings dialog enter the IP address, subnet-mask and default gateway. 

You can omit the default gateway if you are using the PC and robot on the same network segment. 
Click [Setting] to set the specified IP address etc., to the robot. 

 

 
 
3. Turn the power to the robot OFF and then ON again to apply the settings. 
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5.4 Set Up Ethernet Communication Settings on Your PC 
Register the robot’s name and IP address to JR C-Points II to set the subject robot. Settings made 
here with JR C-Points II sets up communication with the subject robot. 
 
1. Select “Robot” from the menu bar and click “Ethernet Settings” from the pull-down menu. 
 
2. Click [Register] on the Ethernet Settings dialog. 
 

 
 
3. Once the register robot dialog is displayed, enter the robot’s name and IP address and click [OK] to 

register the robot. 
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4. JR C-Points II returns to the Ethernet settings dialog. Select the registered robot and click [Set 
Target] to complete the Ethernet communication settings for the subject robot.  
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6. HOW TO READ THE DISPLAY SCREEN 
 

 

 
 
• Title bar: ······························· Displays the name of the C & T data file currently open. 
• Menu bar: ····························· JR C-Points II menu: Click an item to display its pull-down menu. 
• Tool bar: ······························· Shortcut icon alignment. 
• Pull-Down menu: ···················· Appears when clicking an item on the menu bar. 
• Program number and name: ····· The number and name of the program currently open (selected) 
• Point data item: ······················ Items which can be set to point data. 
• Status bar ····························· Displays an explanation. 
• Model name, axis info, axis- 

configuration, support axis ········ Displays the model and axes number of the connected robot. 
  

(C & T data file name) 
Menu Bar 

Pull-down Menu 
Program number and program name 

Title Bar 

Tool Bar 

Model, axes number, mechanical axis 
configuration, support axis Point Data Item Name Status Bar 
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6.1 Icon Function List 
Icon Function Corresponding Menu Operation 

 Opens a new (C & T data) file File  New 

 Opens an existing file File  Open 

 Overwrites the file currently open File  Save 

 Print File  Print... 

 Cuts the selected point Edit  Cut 

 Copies the selected cell to the clipboard Edit  Copy 

 
Pastes the selected item from the clipboard to 
the cell 

Edit  Paste 

 Refresh View  Refresh 

 
Displays the JR C-Points II version 
information. 

Help  About... 

 Changes the display language View  Set Language 

 Edits the point as a graphic Edit  Edit Graphic Point 

 Point Job Data  Point Job 

 PTP Condition Data  Additional  PTP Condition 

 CP Condition Data  Additional  CP Condition 

 Tool Data Data  Additional  Tool Data 

 Pallet Routine Data  Additional  Pallet Routine 

 Work Adjustment Data  Additional  Work 
Adjustment 

 Execute Condition Data  Additional  Execute 
Condition 

 PLC Program Data  PLC 

 All Program Common Settings Data  All Program Common 
Settings 

 Adds a (PTP) point to the end of the program Edit  Add Point 

 Inserts a (PTP) point Edit  Insert Point 

 Deletes a point Edit  Delete Point 

 Adds a PTP point to the end of the program*1 

These are tool bar icons only 

 
Adds a PTP evasion point to the end of the 
program*1 

 
Adds a CP start point to the end of the 
program*1 

 
Adds a CP passing point to the end of the 
program*1 

 
Adds a CP stop point to the end of the 
program*1 

 
Adds a CP arc point to the end of the 
program*1 
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Adds a CP end point to the end of the 
program*1 

These are tool bar icons only  
Adds a circle start point to the end of the 
program*1 

 
Adds a circle center point to the end of the 
program*1 

 Performs mechanical initialization Robot  Meca Initialize 

 Operates the robot in JOG mode Robot  JOG 

 The robot makes a GO movement Robot  Go Move  

 
The robot makes a GO movement and then 
moves to the next point 

Robot  Go Plus Move 

 Instructs the robot to make a point run Robot  Point Playback 

 Instructs the robot to make a test run Robot  Test Running  

 Adds a program Program  Add Program 

 Deletes the currently selected program Program  Delete Program 

 Program individual settings Program  Program Individual 
Settings 

 
NOTE 
You can select to display or hide icons from [Toolbar] on the [View] pull-down menu. 

 
*1 The point string added varies depending on the application specifications. The point string also 

varies depending on the settings for new point types entered with PC customizing. 
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7. OPERATION PROCESS 
 

 
Use this application to create C & T data and use it on the robot according to the following process: 
 

 
 
*1 “File” refers to the C & T data file saved on the PC. 
*2 Back up the data file as protection against a possible transmission error before sending C&T data to 

the robot. 
  

Receive 
from the robot 

Open File New 

Edit 
C & T data 

Save File 

(Backup) 

Send 

C & T data 

to the robot 

Open 

C & T data 

Open 

C & T data 

Open 

C & T data 

*1 

*2 
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8. C & T DATA 
 

 
This section explains C & T (customizing and teaching) data handled by this application.   
When opening, saving, sending, or receiving data through this application, everything is handled as 
one unit (C & T data) as shown below. However, with program or point data, you can save a specified 
program/point data number and individually send/receive this to the robot. 
Only one unit of C & T data can be kept in the robot at one time. Therefore, if you send C & T data from 
the PC, the data stored on the robot is overwritten (once the data is overwritten the original data is 
lost). 
 
PC customizing setting information and point graphic editing data (page settings, grid size settings, 
auxiliary lines, imported figures etc.) are not included in C & T data and therefore cannot be 
sent/received from the robot. Point graphic editing data content is saved onto file only, therefore open 
the saved file and reedit the data from there. 
 

 
 
C & T data includes the robot’s setting values and data. 
There are teaching pendant settings and other such robot setting values which cannot be modified 
from a PC. 
 
  

C & T data 

 
Customizing 

data 

 
Teaching 

data 
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8.1 Teaching Data Configuration 
Teaching data retains data for robot movements. 
To execute basic robot operations, it is possible to do this from teaching data settings alone. 

 

 
  

Teaching Data 
 

Program 1 – 999  
 

Point Data 

Individual Program Settings 

Point Jobs (1 – 500) 

Additional Functions (1 – 50), Work Adjustments (1 – 3000) 

PLC Programs (1 – 50) 

Common Data Settings (common value settings of variables) 

Condition Data Settings (condition settings for values of variables) 

All Program Common Settings 

Global Variable (when created without logging in) 

Keeping Variable (when created without logging in) 

User Functions (when created without logging in) 

Aliases (when created without logging in) 
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8.2 Customizing Data Configuration 
Customizing data saves data for customizing robot movements. Settings other than T.M.C settings are 
owned by the account which created them and can be set with a protection mode. 
T.M.C. settings are data for content display and default values when teaching. The content of PC 
customizing settings is not included in customizing data. 
With customize data, if you are not logged in as a given user, you cannot create or delete customize 
data. 

  

T.M.C. Settings 
 Default All Program Common Settings 

Display Order 

Caption Settings 

Teaching Mode Display Items 

Teaching Operations 

Common Setting Variables 

Condition Setting Variables 

Program Setting Variables 

Point Types 

Global Variables (when created logged in) 

Keeping Variables (when created logged in) 

User Functions (when created logged in) 

Aliases (when created logged in) 

Point Jobs (501 – 1000) 

Additional Functions (51 – 100) 

PLC Programs (51 – 100) 
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9. CREATING A NEW C & T DATA FILE 
 

 

 
NOTE 
You cannot open multiple C & T data files at one time. If a C & T data file is already open, close it 
before opening a new C & T data file. 

 
 
  

 

This creates a new C & T data file. 
Select “File” on the menu bar and click “New” from the pull-down 
menu, or click on the “new file” icon on the tool bar. 
If you have an unsaved C & T data file open, a save confirmation 
dialog will appear. 
 
A new C & T data file is created.  
The C & T data is in its initial state with no program or point data 
registered and therefore the screen is blank. 
 
A new C & T data file opens when the application starts up. 
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10. OPENING/SAVING A FILE 
 

 
This section explains how to open or save to a C & T data file stored on the PC. To change or open the 
C & T data stored in the robot, refer to “10.3 Opening a C & T Data File” – “10.5 Load a JCS (.jcs) File”.  
Before sending the C & T data to the robot, save the data onto a backup file as a safeguard against 
contingencies. The saved file is used as a C & T data backup file. 
 

NOTE 
When you select “New”, “Points II CP2*Document” (“*” varies depending on the specifications) from 
the “File” tab in the menu bar in Windows Explorer etc., a new C&T data file is created. The C&T file 
created using this method acquires the model information last used previously in JR C-Points II; 
however, please do not create files using this method, as the model information may be inaccurate.  

 
 
10.1 Saving a File 

 
 
10.2 Save Partial Data to a File 
You can save a portion of C & T data, such as a specific program or specific point job data.  
Select the location where you wish to save the file and enter the file name. The Save File selection 
dialog box (tree view) appears. Check the data box you wish to save and click [OK]. Only the checked 
data is saved. 
  

Click “Save” or “Save As” on the “File” pull-down menu: 
 
When saving data to a file, if any numerical data parameters 
included in the C & T data exceed the input range, the data is 
saved as the minimum/maximum parameter value for that input 
range. 
However, if point job data and/or additional function data 
numbers set to point data exceed the input range, they are not 
registered. 
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10.3 Opening a C & T Data File 
1. Select “File” on the menu bar and click “Open” from the pull-down menu. 

You cannot open multiple C & T data files at one time. If a C & T data file is already open, close it 
before opening the new C & T data file you want. 

 
2. Select the file you wish to open. 
 
 
10.4 Open a Data Segment File 

 
Data source Data contained in program 

Open C & T data file 1, 2, 3, 4, 5 

Portion of C & T data file 1, 2, 3 

 
For this above example, the data duplication confirmation screen for Program 1 appears since 
Program 1 is contained in both the open C&T data file and in the partial C&T data file. 
 
 OverWrite 
Program 1 in the open C & T data file is deleted, program 1 from the selected partial C & T data is 
registered, and then the data duplication screen for program 2 is displayed. 
 
 ThrowOut 
Program 1 of the selected portion of C & T data is not registered and the data duplication screen for 
program 2 is displayed.  

1. Click [Open Data Segment] on the [File] 
pull-down menu. 

 
2. If C & T data is open, the selected portion of C 

& T data is loaded to the open C & T data file. 
If the open C & T data and the selected partial 
data have overlapping content, the Data 
Duplication confirmation screen to the right 
appears. Content that does not overlap is 
automatically written to the open C & T data 
file. 

 
 
Example: The file and data content is as follows: 
 

36 



PC Operation Desktop Robot JR3000 

 Import 
Select (check) the method for program import. Refer to the following import handling methods: 
• Change the registered program number 

Change the number for program 1 of the currently open C & T data to the number designated as 
the “Registered Number” while program 1 of the partial data is registered as is with its original 
number. 

• Change the imported program number 
Change the number for program 1 of the partial data to the number designated as the “Import 
Number” and register it. 

 
NOTE 
If the selected data has only one setting (such as [All Program Common Settings] or [Common 
Data Settings]), you can select either [Import] or [ThrowOut]. 

 
 
10.5 Load a JCS (.jcs) File 
You can load a created JCS file. A JCS file is a CSV (comma-separated-values) descriptor file for point 
data type information and coordinate information. Please refer to “25. JCS File Format” for JCS file 
format information. 
 
1. Click [Import] on the [File] pull-down menu. 
 
2. Select the file you wish to open.  

In the JCS file, the unit of length measurement is not registered. Here you can select a 
measurement unit (millimeters/inches). 

 
3. Select which program number in the C&T data to attribute to the data in the JCS file. Then click 

[OK].  
 
 If there is no open C&T Data 
New C&T data is opened as if there is only one program. 
 
 If the C&T Data Is Already Open 
This opens the selected program number of the open C & T data. A new program is added to the 
currently open C & T data. 
 

NOTE 
Once opened, a JCS file cannot be saved again as a JCS file; it must be saved as a C&T data file 
(.cp2*). (“*” varies depending on the specifications).   
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11. SENDING AND RECEIVING C&T DATA 
 

 
To actually use created C & T data, it is necessary to send it to the robot. Also, to open C & T data 
currently being used by the robot, your PC needs to receive it from the robot. 
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11.1 How to Receive C&T Data 
Click [Robot] on the menu bar, then click on [Receive C & T Data] on the pull-down menu. The 
following window appears. 

 

NOTE 
You cannot open multiple C & T data files at one time. If a C & T data file is already open, close it 
before receiving new C & T data from the robot. 

 
 Segment Receive  
If you wish to receive a specified program or point job data, click [Segment Receive] on the Receiving 
C & T Data dialog box. A data selection screen (tree view) appears. Check the data you want to 
receive and click [OK]. You will receive only the data you checked. 

  

 Receive 
Click [Receive] to begin receiving the 
aforementioned C & T Data from the 
robot. When the transmission is 
complete, the received C & T data 
opens. 
 
If you put a check in “When receiving 
C & T data, the Point Graphic Edit 
data is left over” and receive data, 
Point Graphic Editor’s page settings,  
grid settings, auxiliary lines, imported figure information are saved and the C & T data is received. If 
you receive data without putting a check here, this information is erased. 

NOTE 
If you click [Segment Receive] while 
another C & T data file is open with 
duplicate data, a data duplication 
confirmation screen for the received 
data file appears. If you wish to 
overwrite the contents, click [Yes]. If you 
wish to change the number, select [No]. 
Select the desired number on the 
pull-down menu in the data duplication 
screen shown to the right, and then click 
[Receive]. 

39 



PC Operation Desktop Robot JR3000 

11.2 How to Send C&T Data 
Click [Robot] on the menu bar, then click [Send C & T Data] on the pull-down menu. The dialog box 
shown below appears. 

 

 Send 
Click [Send] on the Sending C & T Data dialog box. The PC starts to send the C & T data to the robot.  
 

NOTE 
The robot can only hold one unit of C & T at one time. Accordingly, if you send C & T data from the 
PC to the robot, the data stored in the robot will be overwritten (deleted).  
If you want to keep the C & T data currently stored in the robot, close the data file, click [Receive 
C&T Data] and save the data as a file on your PC. 

 
 [Segment Send] 
If you wish to send only specific programs or point job data, click [Segment Send] on the Sending C & 
T Data dialog box. A data selection screen (tree view) appears. Check the data you wish to send and 
click [OK]. The PC sends only the checked data. 
When sending data, if any parameters of numerical data included in the C & T data exceed the input 
range, the data is saved within the minimum/maximum input range for that parameter. However, if 
point job data and/or additional function data numbers set to point data exceed the entry range, the 
data is not registered. 
 

NOTE 
• If you send a segment of data which contains duplicate data, the robot’s data is overwritten by the 

data that was sent. Note that no confirmation message appears. 
• When transmitting C&T data while logged in on the robot side, if the account you are logged in 

under is not included in the C & T data being sent the robot will forcibly log you out.   
• The code displayed at the time of a transmission error is for malfunction inquiries. Be sure to relay 

the code and error content when making an inquiry.  
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12. HOW TO CHECK THE CONNECTION AND 
SYSTEM INFORMATION 

 

 
Click “Robot” on the menu bar and then click “SystemInfo” on the pull-down menu. System information 
for the subject robot is loaded. 

NOTE 
“Robot System Software Ver. Number” is the version number for system software built into the 
robot, not the JR C-Points II version number. 

 

 

 

The PC IP address is 
set up 

The robot is ready to 
interface with the PC 

The LAN cable is 
connected 

 

 

 

The robot IP address 
is set up 
 

YES 

YES 

YES 

YES 

YES 

The subject robot is 
connected 

Also, use “SystemInfo” to check the connection 
between the PC and the robot. When 
communication with the robot fails or when the robot 
does not operate, check to see if the robot 
configuration information can be loaded.  
 
If the robot configuration information cannot be 
loaded, check the “When you can’t interface” chart 
shown below: 
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13. SCREEN DISPLAY 
 

 
This section explains how to edit or refresh the screen display. 
Click [View] on the menu bar to display the pull-down menu shown below. 

 
13.1 Tool Bar 
Click [Tool Bar] to display or to hide the icon blocks on the tool bar.  
 
 
13.2 Status Bar 
Click [Status Bar] to display or hide the status bar. 
 
 
13.3 Refresh 
Click [Refresh] to redisplay the point data. 
When redisplaying the data, if any numerical data parameters exceed the input range, the data is 
displayed within the minimum/maximum parameter input range. However if point job data and/or 
additional function data numbers set to point data exceed the entry range, the data is displayed as 
unregistered. 
 
 
13.4 Change View 
Click [Change View] to select the point data alignment method: horizontal or vertical.  
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13.5 Column Width Reset 
This resets the column width to the default setting when point data is displayed vertically. 
(With the horizontal view, the column width is reset to the default setting when the program is 
changed.) 
 
 
13.6 Unit System 
Click [Unit System] to select the unit of length or coordinates from the following: 
• Millimeters 
• Inches 
 
 
13.7 Set Language 
Select the display language for JR C-Points from the following four languages in the Application 
Language section. By selecting the application language you also select the corresponding caption 
display language.  
 Application Language 

• English 
• Japanese 
• German 
• Simplified Chinese 

 
You can select which language to display the captions for point type and Customizing Mode defined 
variables from the following languages: 
 Caption Language 

• English 
• Japanese 
• German 
• Italian 
• Spanish 
• French 
• Korean 
• Chinese (simplified) 
• Czech  
• Vietnamese 
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14. TEACHING DATA 
 

 
14.1 Program 

14.1.1 Open a Program 
A program is a part of C & T data. To open a program, first open the C & T data.   
 Opening a New Program 

To open a new program, click [Add Program] on the [Program] pull-down menu or select the  icon 
on the tool bar. The dialog box shown below appears. 
Select a new program number you wish to register and enter a program name.  
 
Once the program name is transmitted to the robot, it is valid for the first 40 – 120 characters on the 
robot side (teaching pendant display) depending on the characters used. 
Note that you cannot select any program number that is already registered. 

 
 
 Opening an Existing Program 
Click on the program name display area on the tool bar. The list of programs included in the C & T data 
appears. Select the program you wish to open. 

 

  

Program number Program name  

You can also display and select from the 
program list by clicking [Program] on the 
menu bar and [Program Change] on the 
pull-down menu. 
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14.1.2 Individual Program Settings 
Click [Program] on the menu bar and either click [Individual Program Settings] on the pull-down menu 

or select the  icon on the tool bar. The dialog box shown below appears. Click the tab you want to 
set and enter or select the desired values. After setting the values, click [OK]. 
If editing items in tabs other than individual data, you need to put a check in [Individually Set Program 
Data]. 
If you do not put a check in [Individually Set Program Data], the contents set in All Program Common 
Settings apply when the robot makes a run. By putting a check in [Individually Set Program Data] the 
contents set here apply when the robot makes a run.  
If you click the [Restore Default Values] button, the values revert to the default values set in the All 
Program Common Data Settings. 
 

NOTE 
• Take caution if you execute [Restore Default Values] as the program name is deleted. 
• Depending on the Customizing Data settings the [Application Data Settings] button is sometimes 

not shown in the dialog box or it appears under a different name.  

 
  

Tab 
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14.1.3 Point Data 
When opening a program by clicking [Add Program], the point data are blank. 
To register one or more points in a program, click [Add Point] as many times as necessary. 

 
 Enter/Change a Value 
Click the cell and enter the value you want to register.   
In the [Type] row, the [] mark appears on the right of the cell when you click on it. Click this to display 
a list of point types. Select the point type you want to register from the list. 
 

NOTE 
For values such as coordinates etc., you can enter up to 3 digits after the decimal point, however, 
after the third digit the values are rounded off when displayed on JR C-Points II. In addition, when a 
value that has more than 3 digits after the decimal point is forwarded to the robot, the digits after the 
third decimal place are cut off. The R axis settings have up to 2 decimal digits and the line speed 
settings have up to 1 decimal digit. 

  

Point data item Point data 

Cell 
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 Edit 
Select a cell or point you want to edit and click [Edit] on the menu bar. The Edit menu appears. 
This menu also appears by selecting a cell or a point you want to edit and right-clicking on it. 
To select a point, select all cells included with that point (excluding the point number cell) or click on the 
point number. 
 
 
 Cut 
Cut operations are made with single point units.  
Select a cell and click [Cut] on the [Edit] pull-down menu. The points included in the selected cells are 
deleted. 
After the [Cut] operation, select a cell and click [Paste] on the [Edit] pull-down menu. The cut points are 
inserted in front of the selected cell. 
 
 
 Copy 
• Cell 

Select a cell as the copy source and click [Copy] on the [Edit] pull-down menu.  
Then select a copy destination and click [Paste] on the [Edit] pull-down menu.  
The copy source cell is overwritten into the copy destination cell. 

• Point 
Select a point as the copy source and click [Copy] on the [Edit] pull-down menu.  
Then select a copy destination and click [Paste] on the [Edit] pull-down menu. The copied point is 
inserted in front of the point where the cursor is placed.  
Click [Paste After Last Point] to add the copied point to the end of the program.   

 
 
 Paste/Paste After Last Point 
By using these functions, you can paste not only the “clipped” or “copied” cells and points but also data 
from tables in other applications, such as Microsoft Excel® and Word®.     
 
 
 Add Point 
Click [Add Point] on the [Edit] pull-down menu. A point is added to the tail end of the point data 
alignments.  
 
 
 Insert Point 
Click [Insert Point] on the [Edit] pull-down menu. A point is inserted in front of the point data where the 
cursor is placed.  
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 Delete Point 
Click [Delete Point] on the [Edit] pull-down menu. The point data where the cursor is placed is deleted. 
 

NOTE 
[Add Point], [Insert Point], and [Delete Point] can also be done by clicking the icons on the tool bar.  

 
 
 Block Copy* 
Block copying is done with single point units. 
Select a cell and click [Block Copy] on the [Edit] pull-down menu. The Block Copy dialog appears. 
Specify the point range for the copy source, copy count (number of copies), the offset amount, and 
click [OK]. The copied point(s) are inserted directly behind the copy source points. 
 
 
 Mirror Copy (Right-Left/Front-Back)* 
Mirror copying is done with single point units. 
Select a cell and then click [Mirror Copy] from the [Edit] menu. The Mirror Copy dialog appears. Specify 
the point range for the copy source and the mirror position and click [OK]. The copied points are 
inserted directly behind the copy source.  
 
 
 Position Offset* 
Offset the position with single point units. 
Select a cell and click [Position Offset] from the [Edit] menu. The Position Offset dialog appears.  
Specify the position range and offset amount for the point you want to offset and click [OK]. The 
coordinates for the designated point are converted.  
 
 
 Block Rotation* 
Coordinates are converted with single point units. 
Select a cell and click [Block Rotation] on the [Edit] pull-down menu. The block rotation dialog appears. 
Enter the range, center of rotation, and rotation angle for the points you want to change and click [OK]. 
The designated point coordinates are converted. 
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 Multiple Line Speed 
Point line speeds included within specified ranges can be converted by a percentage. If the converted 
values exceed the line speed setting range, the values are set to the appropriate maximum or 
minimum value. 
Click [Multiple Line Speed] on the [Edit] pull-down menu. The Multiple Line Speed dialog box appears. 
Enter the Start Point/End Point Numbers and the Line Speed Ratio. 
 
 
 Reverse Point 
Use this function to reverse the order of points within a designated range.   
Click [Reverse Point] on the [Edit] pull-down menu. Enter the Start Point/End Point Numbers. 
Example: Start Point Number: 3, End Point Number: 5  
 P1, P2, P3, P4, P5, P6  P1, P2, P5, P4, P3, P6 
 
 
 Convert to Relative Coordinates* 
Use this function to convert the point coordinates included in the currently selected program to relative 
coordinates. 
 
 
 2 Points Position Conversion* 
Offset the point coordinates or rotation so as to overlap all of the lines joined up from the two points of 
the conversion source and the two points of the conversion destination. 
You can select to specify the target data to either a program or all data. 
After entering the two points for the conversion source position and the two points for the conversion 
destination position, click the [Converting Amount] button to convert and display the conversion 
coefficient. 
Push the [Converting Data] button to apply the conversion. 
You can save the conversion source position, conversion destination position and the conversion 
coefficient to the robot. When the robot and PC are able to interface, click the [Send] button to record 
this data to the robot. Also, if you click the [Receive] button, you can load the conversion source 
position, conversion destination position and conversion coefficient to the 2 Points Position Conversion 
dialog. 
 
 
 Point Graphic Editor* 
You can put the point data into a visual display and edit it.  
Load a DXF file or a Gerber data file and while using the loaded data you can teach point data. 
For further details, please refer to “18. Point Graphic Editor”. 
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*If there are multiple axes with the same assignments, the axes enabled (set to valid) in the Drive Axis 
Valid/Invalid settings (robots equipped with auxiliary axis functions) of the “Other” tab in Individual 
Program Settings, and/or All Program Common Settings are subject to modification. Also, if there are 
multiple axes enabled (valid), or if there are no enabled axes (invalid), modification is performed on 
the axes with the smaller numbers. 

 
 
14.2 Point Job Data 
Point job data is a portion of C&T data. To create and edit point job data, you need to open the C&T 
data first. 

Either click [Point Job] on the [Data] pull-down menu or click the  icon from the tool bar. A list of the 
point job data appears.  

 
 
14.2.1 Copy 
1. When you want to create new point job data similar to existing point job data, it is convenient to 

make a copy and edit the copied data. 
Select the point job data you want to copy from the list and click [Copy]. A selection dialog or entry 
dialog box for the copy destination job number appears. 

2. Select or enter the copy destination point job number.  

List 

Currently selected point job data content 
(No. 2 in this example) 
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14.2.2 Delete 
1. Select the point job data you want to delete from the list and click [Delete]. 
2. The Delete confirmation screen appears. Check that the number is correct and click [OK]. 
 
 
14.2.3 New (Add) 
1. Click [Add] at the bottom of the dialog box and select the point job data number you want to create. 

Numbers already registered cannot be selected. Select a number and the point job data editing 
dialog appears. 

 
NOTE 

You can change the size of the point job data editing dialog box. Click the  button on the upper 
right corner of the dialog box to make it full-screen. Click and drag the edge of the dialog box. Its 
size will change according to how much you have moved it. 

 
2. Select (click) the desired command. The necessary parameters for the selected command can 

now be selected or entered. 
 
3. Enter or select (click) the parameter(s). Numeric values, characters, and expressions can be 

entered directly using the keyboard. 
 
4. Click [Register]. One command line is registered and the highlight bar shifts to the next line. 
 
5. Repeat the above steps 2 – 4 for the commands that you want to input. 
 
6. After entering all the commands, click [OK]. 
 
To name the point job data, you can use up to 40 one-byte characters. 
 

NOTE 
The above steps 2 – 6 are also used when entering Additional Function Data and PLC Program 
commands. 
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Enter a numeric value 

Command selection 

Selection Command line 
Enter characters  

or expressions. 
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14.2.4 Edit 
1. If you want to modify existing point job data, select the point job data number you want from the list 

and click [Edit] at the bottom. The point job data editing dialog box appears. 
2. After the following operations, click [OK]: 
• Add a Command 

Select the line after the last command line (the line that contains no command) from the list on the 
left side of the screen, and just the same as you do for entering a command; select (click) or enter 
the command and the necessary parameter(s) and click [Register].  

• Insert a Command 
On the left side of the screen select the line you want to add a command to. Then, the same as you 
do for entering a command; select (click) or enter the command and the necessary parameter(s) 
and click [Register].  
A command line is inserted, and all subsequent command lines shift down. 

• Delete a Command 
On the left side of the screen, select the command line you wish to delete and click [Delete]. The 
selected command line is deleted and the proceeding commands shift up. 

• Change a Command 
Insert a new command and delete the old command. 

 
 

NOTE 
This editing operation is also used when changing Additional Function Data and PLC Program 
commands. 
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14.2.5 Decompile (save as a text file) 

 
 
 
14.2.6 Compile (Import a text file) 

  

Point job data can be saved in text file format. 
 

Click [File] on the menu bar and select 
[Decompile] on the pull-down menu. The dialog 
box shown to the right appears. 
Check the point job data you want to save as a 
text file and click [OK]. 
The decompile results appear.  
To save the data, click [Save As] and enter a file 
name.  
The default file extension is saved as “.cds”; 
however, you can change it to “.txt”. 
 

NOTE 
Please be careful when decompiling or 
compiling if there are discrepancies in the 
measurement units (millimeters/inches) as the 
data may not be able to load correctly. 

You can read point job data 
saved in text file format by 
clicking [File] on the menu bar 
and selecting [Compile] on the 
pull-down menu. 
 

Text files created using other 
applications, such as Microsoft 
Word® can also be loaded. 
(However, note that the data 
format must be the same as a 
“.cds” file.) 
 

After loading the data, the 
dialog box shown above 
appears. 

54 



PC Operation Desktop Robot JR3000 

Click [File] to select the next file you want to load. 
Click [Import] to register the loaded data to the currently open C & T data. 
 
After loading the data, the Data Duplication confirmation screen shown below is displayed if the C & T 
data and the imported point job data overlap. However, if you put a check in [All subsequent data is 
overwritten.] and click [Import], overwrite confirmations are not displayed and all data is overwritten. 
 

 

• Change the imported program number 
Put a check in [Import Number] and specify the number to which you want to import the point job. 

 
• The following processing is applicable from the following duplicate data. 

Put a check in [All subsequent data is overwritten.] to overwrite all subsequent duplicate data. 
Put a check in [All subsequent data is read and thrown away.] to dismiss all subsequent duplicate 
data. 

 
  

• [OverWrite] 
The point job data currently registered is 
deleted, and the data being imported is 
registered in its place. 

 
• [ThrowOut] 

The point job data being imported is not 
registered (thrown out). 

 
• [Import] 

Select (check) the program import handling 
method and click this button. 

 
• Change the number of registered programs 

Put a check in [Registered Number] and 
specify the number to which you want to 
change the currently registered point job data. The point job data being imported is registered with 
no change to its point job data number. 
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14.3 Additional Function Data 
Additional function data is a part of C & T data. To create or edit additional function data, first open the 
C & T data. 
Either click [Additional] on the [Data] pull-down menu and select the additional function data you want 

to create or change or select the icon ( ) from the tool bar. A list of the selected 
additional function data is displayed. 

 

 
To create new additional function data, click [Add] and select the additional function data you want. 
To change existing additional function data, select the data number you want to change from the 
existing data list (on the left of the window) and click [Edit]. The edit dialog box for the additional 
function data you selected is displayed. 

  

Contents of the currently selected 
data (No. 1 in this example) 
  

Data list 
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14.3.1 Edit 
To edit existing additional function data, select the data number you want from the existing data list and 
click [Edit]. The edit dialog box for the selected additional function data is displayed. 
 
• [PTP Condition], [CP Condition], [Tool Data], [Pallet Routine], [Work Adjustment] 

Select or enter the item you wish to register from the edit dialog box. You can enter names for 
[Pallet Routine] and [Work Adjustment]. Once the name is transferred to the robot, it is valid with up 
to 40 halfwidth characters on the robot side (teaching pendant display). 

 
• [Execute Condition] 

Enter or change commands the same as you do for point job data. After entering or changing 
commands, click [OK] in the edit dialog box. 

 
 
14.3.2 Copy 
Select the additional function data number you wish to copy from the existing data list and click [Copy]. 
The selection or entry screen for the copy destination additional function data number is displayed. 
Select or enter the copy destination data number. 
 
 
14.3.3 Multi-Copy 
For [Work Adjustment] you can use one work adjustment and make multiple copies. 
Select the additional function data you want to copy from the existing list and click [Multi-Copy]. 
A dialog for entering or selecting the copy destination’s [Start No.] and [End No.] appears. Select or 
enter the additional function copy destination numbers. 
 
 
14.3.4 Delete 
Select the desired additional function data number you wish to delete from the existing data list and 
click [Delete].  

Click [Add] on the settings dialog box 
to display the unregistered number 
list. 
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14.4 PLC Programs 
A PLC program is part of C & T data. Before creating and editing a PLC program, you first need to 
open the C & T data. 

Either click [Data] on the menu bar and click [PLC] on the pull-down menu or click the  icon on the 
tool bar. The PLC program data list is displayed. 

 
 
 
14.4.1 New (Add) 
Below the list, click [Add] and select the PLC program number you want. The edit dialog box for the 
PLC program for the number you selected is displayed. 
 
 
14.4.2 Edit 
To edit an existing PLC program, select the data number you want from the existing data list and click 
[Edit]. The edit dialog box for the PLC program for the number you selected is displayed. 
Entering or editing PLC program data is the same as with point job data. You can add a name to a PLC 
program. Once the name is transferred to the robot, it is valid with up to 40 halfwidth characters on the 
robot side (teaching pendant display). 
 
 
14.4.3 Copy 
Select the PLC program number you want to copy from the existing data list and click [Copy].  
Select the number for the copy destination, or enter the number and the dialog box appears. Select or 
enter the copy destination data number. 
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14.4.4 Delete 
Select the PLC program number you wish to delete from the data list and click [Delete]. 
 
 
14.5 Common Data Settings 
[Common Data Settings] is an item defined in Customizing Mode with items and numerical values set 
in Teaching Mode. [Common Data Settings] cannot be selected if not defined (the default settings for 
standard specification models are not defined). 
Also, item names and item names set in Customizing Mode (captions) are displayed here. [Dispenser] 
for dispensing specifications and [Devices Signals] for screw tightening specifications are also 
considered [Common Data Settings]. 
 

 
 
Click [Data] on the menu bar and click [Common Data Settings] on the pull-down menu. The Common 
Data Setting Edit dialog box shown on the next page is displayed. 
When you want to change the value of an item, click the corresponding value cell. If the item is 
categorized as [Number Type], you can enter the value into the cell. If the item is categorized as 
[Select Type], the [] mark is displayed on the right side of the cell. Click the [] mark and select the 
item you want to set. If the item is categorized as a [String Type], the [...] mark is displayed on the right 
side of the cell. Click the [...] mark, and the edit dialog box appears. Set the items you want. 
  

The wording appears gray when you 
cannot select it.   
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If the IO alias settings are defined, the [IO Signal Setting] button is displayed on the Common Data 
Setting Edit screen. If COM alias settings are defined in Customizing Mode, the [COM Signal Setting] 
button is displayed.  
 
Click the [IO Signal Setting] or [COM Signal Setting] button. A signal list included in the [Common Data 
Settings], similar to the one on the next page, is displayed. 
If you want change a setting, click the column for the signal you wish to change. If the item is 
categorized as [Number Type], you can enter the value. If the item is categorized as [Select Type], the 
[] mark is displayed. Click the [] mark and select the item you want to set. 
Note that the signal width may be unchangeable depending on the Customizing Mode settings. In this 
case the [ – ] signal appears in the column.  
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NOTE 
In some cases IO-SYS (sysIn and sysOut) and Fieldbus (fbIn and fbOut) signal functions are 
pre-assigned. To use these signals for something other than such pre-assigned functions, it is 
necessary to change the function assignment of the All Program Common Settings [IO-SYS 
Function Assignment] or [Field Bus Function Assignment] to [Free]. 

 
 
14.6 Condition Data Settings 
[Condition Data Settings] is an item defined in Customizing Mode. If it is not defined (such as with the 
default for standard specifications), you cannot select this item (from the menu).  
Item names and item names set in Customizing Mode (captions) are displayed here. [Devices Signals] 
for screw tightening specifications, are not program individual settings, but they are [Common Data 
Settings]. 

  

The wording appears gray when you 
cannot select it.   
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Click [Data] on the menu bar and click [Condition Data Setting] on the pull-down menu. A list of 
condition data settings is displayed. 
 
 
14.6.1 New (Add) 
Click the [Add] button below the list, and select a number from the unregistered number list. The 
condition data settings dialog for the selected number is displayed. 
 
 
14.6.2 Edit 
To edit existing condition data, select the condition data number you want from the existing data list 
and click [Edit]. The condition data settings dialog for the selected number is displayed. 
 
 
14.6.3 Copy 
Select the condition data number you want from the existing data list and click [Copy]. The Copy 
Condition Data dialog box will appear. Select or enter the copy destination data number. 
 
 
14.6.4 Delete 
Select the condition data number you wish to delete from the list and click [Delete]. 
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When you want to change a parameter value, click the corresponding “value” cell. If the item is 
categorized as [Number Type], you can enter the value into the cell. If the item is categorized as 
[Select Type], the [] mark is displayed. Click the [] mark and select the item you want to register. If 
the item is categorized as [String Type], the [...] mark is displayed. Click the [...] mark, and the edit 
dialog box appears. Set the item you want. 
You can also enter a name for the condition data. Up to 40 one-byte characters can be used. 
 
 
14.7 Identifiers 
Identifiers are the names given to each set of data. These are needed for all of the following types of 
data: Common Setting Variables, Condition Setting Variables, Program Setting Variables, Point Type 
Definitions, Global Variables, Keeping Variables, User Functions, and Aliases etc. 
Also note that you cannot have duplicate identifiers within the same C & T data. 
 
• You can use up to 40 characters from a combination of Roman uppercase letters, Roman 

lowercase letters, numbers, and underbars. You cannot use blank spaces. 
 

NOTE 
Make sure to use a Roman uppercase letter for the starting character. Also, you cannot use 
fullwidth characters. 

 
• Even if the data type is different, you cannot have data with a duplicate identifier. For example, if 

you have the identifier “Time” for a common setting variable, you cannot define a keeping variable 
with the identifier “Time.” 

 
• Even from a different account you cannot have a duplicate identifier. If the identifier you entered is 

not accepted, there is a possibility this identifier is already being used by a different account. 
 
• Identifiers and captions are different. Captions are names used to make displays easy to 

understand. You are able to use duplicate captions. 
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14.8 Variables 
You can define variables which are useable within point job data. 
Click [Data] on the menu bar and then select [Global Variables]/[Keeping Variables] from the pull-down 
menu. Once selected, a list of variables is displayed. If you want to define a new variable, click [Add] 
and enter an identifier. If you want to edit an existing variable, select the variable you want to edit from 
the list and click [Edit]. 
You can also copy or delete variables from the list by selecting [Copy] or [Delete] respectively. 
 
You can define up to 100 [Global Variables]/[Keeping Variables] respectively. 
 
A variable can be defined from an element to a 3 dimensional array.  

 

 
NOTE 

• Variables are classified into two types; local variables and global variables. Local variables are 
declared by the declare command and only retain values of point job data which include declare 
commands. Global variables are the opposite of local variables and can be referred to from any 
program and any point. All variables other than local variables declared by declare commands are 
global variables. 

• Keeping variables are variables that maintain their values even when the power is turned OFF. 
Keeping values defined here are global variables that maintain their values. 

 
  

1) Element 
2) 1st Dimension 
3) 2nd Dimension 
4) 3rd Dimension 
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14.9 User Functions 
You can define functions which are useable within point job data. 
Click [Data] on the menu bar and select [User Functions] from the pull-down menu. Once selected, a 
list of functions is displayed. If you want to define a new function, click [Add] and enter an identifier. If 
you want to edit an existing function, select the function you want to edit from the list and click [Edit]. 
You can also copy and delete functions from the list by selecting [Copy] or [Delete] respectively. 
 
You can define up to 500 user functions. 

 
 
You can set up to 100 arguments per each function. 
If you want to define a new argument, click [Add Number Type]/[Add String Type] and enter an 
identifier. If you want to edit an existing argument, select the argument you want to edit from the list and 
click [Edit]. 
You can also delete arguments from the list by selecting [Delete]. 
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14.10 Aliases 
With aliases you can set names to IO or COM signals.  
Click [Data] on the menu bar and select [Alias] from the pull-down menu. Once selected, an alias list is 
displayed. If you want to define a new alias, click [Add] and enter an identifier. If you want to edit an 
existing alias, select the alias you want to edit from the list and click [Edit]. 
You can also delete aliases from the list by selecting [Delete]. 
 
You can define up to a combined total of 100 IO and COM aliases. 
 

 
 

NOTE 
Some IO-SYS signals and Fieldbus signals have functions assigned to them in advance. If you 
want to use these signals with functions other than the ones assigned to them, you need to set All 
Program Common Settings [IO-SYS Function Assignment] or [Field Bus Function Assignment] to 
[Free]. 
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14.11 All Program Common Settings 
All Program Common Settings is a part of C&T data. To set All Program Common Settings, you must 
first open the C&T data.  
Select and change the settings for the item you want. 
(See the operation manual Functions III (All Program Common Settings / PLC Programs) for details 
about each parameter.) 
 

 
 
 Restore Default Values 

This resets All Program Common Settings to their default values. You can set the All Program 
Common Settings default values in [Set T.M.C]  [Default All Program Common Settings]. 

 
 
  

Tab 
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15. ROBOT OPERATION VIA PC 
 

 
To establish communication between the PC and the robot or to operate the robot via the PC, click 
[Robot] on the menu bar and open the pull-down menu shown below. 

 

 

NOTE 
You need to remove the teaching pendant from the robot and then use [Changing Modes] to switch 
over to Teaching Mode to set and use [JOG] (JOG Teaching), [GO Move], and [GO Plus Move].  

  

Caution 
Be sure to turn OFF the robot and the PC before connecting or 
removing the cable. Failure to do so may cause data loss or 
malfunction. 
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15.1 Mechanical Initialization  
This initializes the robot. 
Either click [Robot] on the menu bar and select [Meca Initialization] on the pull-down menu or click the 

 icon on the toolbar. The robot initializes. If the robot is not initialized after the robot is turned ON, 
you cannot make the robot move. 
 

 
 
15.2 Go Move 
With a point selected (when the point number is highlighted after clicking on it), click [Robot] on the 

menu bar and click [Go Move] on the pull-down menu, or click the  icon on the toolbar. The robot 
axes move to the selected point coordinates. 
 
 
15.3 Go + Move 
With a point selected (when the point number is highlighted after clicking on it), click [Robot] on the 

menu bar and select [Go Plus Move] on the pull-down menu, or click the  icon on the toolbar.  
The robot axes move to the coordinates of the selected point, and the succeeding point is then 
selected.  

The robot model and axes information set in JR C-Points II. 
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15.4 Point Playback/Test Running 

Click [Robot] on the menu bar and select [Test Run] on the pull-down menu, or click the icon  on 
the toolbar. For a point run, when a point is selected (when the point number is highlighted after 
clicking on it), click [Robot] on the menu bar and click [Point Playback] on the pull-down menu, or click 

the icon  on the toolbar.  
These operations are performed according to the C & T data stored in the robot RAM. If you wish to do 
Point Playback/Test Running using C & T data created with JR C-Points II, first you need to click [Send 
C&T Data]. 
 
 
15.5 JOG (JOG Teaching) 
You can register point coordinates in JOG Mode. 
Place the cursor on the point you wish to register and click [Robot] on the menu bar and click [JOG] on 
the pull-down menu. The JOG dialog box (next page) is displayed.  
To register a point other than a regular point such as the work home position, click the JOG icon 

(  ) in the settings dialog box for that point. 
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15.5.1 JOG Tab 
With this you can do JOG teaching for each axis. If the robot has an R axis, Z axis, or synchronized 
control auxiliary MT1 axis or MT 2 axis, JOG keys and point coordinates for those axes are displayed. 
The auxiliary MT1 axis and MT2 axis JOG keys, point coordinate names, and units are displayed as 
the [Axis Name] and [Unit] settings made with the auxiliary axis configuration for each auxiliary axis. 
For information regarding auxiliary axis configuration, refer to the operation manual Auxiliary Axis 
Functions. 
 

 

 Point Job 
Click the [] mark and a list of the point job data entered into the C&T data is displayed. The robot 
performs the selected point job data. 
However, the robot executes point job data from the C&T data stored in the robot, therefore if the point 
job data you want to execute differs from the point job data in the robot’s C&T data, it is necessary to 
first use the [Send C&T Data] function. 
Also note that for the point jobs performed here, the point job data numbers are not set to the points. To 
set the point job data to a point, close the JOG dialog box, click the desired point data cell and select 
the number you want to set. 
  

 JOG Keys 
Using the JOG keys, move the 
robot axes with the corresponding   
key. Release the key to stop. 
 
 
 Point Number Teaching 
The point number where the cursor 
is placed when the JOG dialog box 
opens is displayed. You can 
change this point number. If you 
use JOG mode for any point other 
than a regular point (such as work 
home position), this is not 
displayed. 
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 Speed  
Push the JOG key continuously to start moving the corresponding axis at a low speed. Keep 
continuing to push the JOG key to gradually increase the axis speed to medium speed. Press the 
SHIFT key (PC) while pressing the JOG key to gradually increase the axis to high speed. When 
moving at high speed, if you release the SHIFT key (PC) while pressing the JOG key you will gradually 
reduce the axis speed to medium speed.  
 
 
 Coordinates  
The point coordinates where the cursor is placed when the JOG dialog box is open. 
Click [Robot Pos’n] to display the current robot position coordinates and [Point Pos’n] to display the 
point coordinates of the designated program. You can also directly enter the coordinate values here. 
 
 
 Register 
Click [Register] to register the coordinates. 
 
 
 GO 
The robot axes move to the coordinates currently displayed in the [Coordinates] cells. 
 
 
 Mechanical Initialization 
This initializes the robot. The robot will not move unless it is initialized after being turned ON. 
 
 
 Close 
This closes the JOG dialog box. 
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If the JOG dialog box is open, you can move the robot axes using a PC keyboard. 
Axis Key 

-X D 
+X F 
-Y E 
+Y R 
-Z C 
+Z V 
-R T 
+R Y 
-MT1 A 
+MT1 S 
-MT2 Z 
+MT2 X 

 
NOTE 
If you cannot operate the robot via the PC in JOG mode, click [SystemInfo] on the [Robot] 
pull-down menu and check the connection between the PC and the robot. Once you have the 
System Information open, check using the “If you cannot operate the robot in JOG Mode” chart on 
the next page. If you still cannot operate the robot via the PC in JOG mode after making all these 
checks, conduct [Failure Diagnosis] (in which case you need a teaching pendant) or contact 
Janome for assistance.  

  

If you cannot operate the 
robot from the PC 

YES 

The robot is in 
Teaching Mode. 

 

The robot is initializing 
after the power is turned 

ON. 

 

YES 

The teaching pendant 
is disconnected. 

 

YES 

 The emergency switch 
is not pushed down.  

YES 
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15.6 External I/O 
Click [Robot] on the menu bar and click [External I/O] on the pull-down menu. The robot’s current 
external I/O status appears. 

 

Red lamps indicate the signals currently ON. 
Click the [ON] and [OFF] buttons on the dialog box to turn the output signals ON and OFF. 
 
15.7 External I/O (IO-FB) 
From [Robot] on the menu bar select [External I/O (IO-FB)] on the pull-down menu. The status of the 
Fieldbus I/O range used for the robot’s function assignments is displayed. 

 
Red lamps indicate the signals currently ON. 
Click the [ON] and [OFF] buttons on the dialog box to turn the output signals ON and OFF.  
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15.8 Fieldbus I/O Display 
From [Robot] on the menu bar select [Field Bus I/O Table] from the pull-down menu. The Fieldbus I/O 
statuses for all areas of the robot are displayed. This dialog is only a display. You cannot set values 
here. 
Depending on the display format, you can switch between hexadecimal and binary displays. 
If you click the [Pause] button, you can stop the display updating. Push the [Pause] button again to 
restart updating the dialog. 
 
 Hexadecimal Display 

 
With the hexadecimal display, one word is displayed as a hexadecimal.  
 
 Binary Display 

 
With the binary display, “1” is displayed for every bit when it is ON, and “_” when it is OFF. 
In the Hex column on the right side of the screen, one word is displayed as a hexadecimal.  
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15.9 Administration Settings 
15.9.1 Administration Settings 
Here you can set various settings such as the robot start channel, COM, Fieldbus, auxiliary axes etc. 
 
 General Tab 
• Start Channel 

You can select from where to receive the start instruction when the robot is in External Run Mode: 
“IO-SYS,” “Fieldbus,” “COM 1,” “User Definition,” or “Ethernet.”  

 
• Change Program Number  

You can restrict which devices can be used to change program numbers. For example, if you 
disable COM1, you will not be able to change program numbers from a device connected to COM1 
on the robot. 

 
• Memory Port Settings 

You can make settings to enable/disable the memory port and enable/disable automatic updates of 
the system program from the memory port. 

 
• Clear Error History 

This deletes all of the error history. 
 
• Clear All Data In Robot 

This deletes all C & T data. Please take caution; if you have not backed up the C & T data, erased 
data cannot be restored. 

 
 COM Settings Tab 
• COM Settings 

This sets the COM 1 – 3 baud rate, character length, stop bit, and parity settings on the robot side. 
 
 Fieldbus Settings Tab 
• Fieldbus Settings 

These are Fieldbus settings for the robot side. Select the Fieldbus type and go through the set up. 
For further details about each Fieldbus module’s settings, please refer to the operation manual 
External Control (IO/Fieldbus). 

 
 MT1/MT2 
These are settings for the axillary axes on the robot side. This does not appear if there are no axillary 
axes. For further details, refer to the operation manual Auxiliary Axis Functions.  
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• Standard Items 
Standard settings such as the resolution and pulse output type of the support axes. 

 
• Homing Type* 

Settings for homing movements. 
Press the [Help] button to display the Go Home Method help screen. 

 
• JOG Movement Speed* 

Settings for JOG movements. 
 
• Axis Name Display 

Enter names for the axes. Depending on the font (or typeface), you can enter up to 10 – 20 
characters for the axes’ names. 

 
• Unit Display 

Enter the measurement unit display. Depending on the type, you can enter up to 10 – 20 characters 
for the measurement unit display. 

 
• IO-MT Function Settings 

Set up the necessary IO functions for axis movements and returning home operations. You can set 
each IO to be disabled / positive logic / reverse logic. 

 
* You can switch between either a “Unit Display” or a “Pulse Display” by changing the “Unit Display” of 
the homing/JOG movement. If you select “Pulse Display”, you cannot edit values. 

 
 
15.9.2 Version Information 
Here you can refer to the robot information. You can check the robot’s system software (system 
program) version number, axis information, MAC address, ON time, run time and the free disk space 
available for teaching data etc.  
You can make a text copy of the display contents by pressing [Copy] on the dialog.  
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15.9.3 Time Settings 

 
 
15.10 Teaching Environment Settings  
 GO Function 
If you press the [GO] key in the JOG dialog ([Robot]  [JOG]), the axes move to the coordinates 
currently displayed in the JOG dialog. You can set the moving speed as well as the PTP arch motions 
for these movements in [GO Function]. 
 
 JOG Function 
You can set the speed at which the axes move when operating the robot in JOG mode and the 
distance moved for one JOG key click in the JOG dialog (Robot  JOG) using [JOG Function]. 
 
 Tool for Teaching 
Here you can enable/disable tools and input tool data during teaching.  
 
 
15.11 Debug 
If you input [Pause] in the middle of your point job data, you can refer to the discretionary expression 
values at that point. You can also overwrite expressions; however, drive commands are disabled. 
 

NOTE 
[Pause] is a built-in variable used in point job commands. When [Pause] is read, the robot stops 
temporarily. 
However, even if [Pause] is set to [Valid], it is disabled when the robot is moving. For example, 
when the robot is performing a job while moving or performing a job during a CP movement and 
you have set [Pause], it is disabled and the robot will not stop. 
(Job While Moving: When the set point job data is repeatedly executed between two points.  
Job While CP Moving: A job done during a CP movement).  

This sets the robot’s system time and date. 
The time and date displayed immediately after opening the time 
settings dialog are the time and date currently set.  
After editing the date and/or time, click [OK] to set the specified 
date and time to the robot. 
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 Change Pause 
Switches “Pause” to [Valid]/[Invalid]. If this is set to invalid, even if “Pause” is read, the robot does not 
stop. In addition, regardless of whether Pause is set to valid or invalid, when the power is turned OFF, 
Pause is invalid the next time the power is turned ON.  
 
 Restart Pause 
This cancels the pause when the robot has stopped temporarily due to the “Pause” function.  
 
 Renew Value 
Overwrites the expression value registered in the list with the current expression value (the value is not 
updated automatically). 

 
 
Input a “Pause” command in the middle of a point job command that you want to debug and do the 
following. If you enter multiple “Pause” commands in a single point job data, you can confirm which 
pause command is currently being used by referring to “Pause No.”. 
 
1. Click on “Change Pause” and set to “Valid”.  
2. Input the expression you want to refer to in “Expression Input” and click on “Register”. Also, if you 

register a substitute expression, the discretionary values can be substituted. 
3. Run the points that have the point job commands you want to debug. You can open the “Robot” 

pull-down menu with the above Reference Value dialog still open.  
  

 

List 
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4. If the robot stops due to a “Pause” command, click [Update Value]. The current values of the 
expressions registered in the list are displayed (the Reference Value dialog cannot be used if other 
dialogs are open).  

5. Click [Pause Restart] to resume the robot’s run.  
 
By selecting a registered expression (it is highlighted) and clicking on [Move Up] or [Move Down] you 
can move the expression up or down in the sequence. To delete a registered expression select 
[Delete] or [Delete All].  
 
 

NOTE 
• For the local variables defined in the point job, you can refer to the values only within the scope of 

variables that exist.  
• The registered expression information in debug is saved as JR C-Points II information and is not 

included in the C&T data file. For this reason, if you change the list contents, they will not be 
restored even if you open the previous C&T data file and restart JR C-Points II.  
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16. MODE CHANGE 
 

 
You can change the robot’s operating mode from the following: 
• Teaching Mode 
• Switch Run Mode 
• External Run Mode 
 
Click [Robot] on the menu bar and click [Changing Mode] on the pull-down menu. The Changing Mode 
dialog box below is displayed. Select the operation mode you want and click [OK]. 
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17. ERROR HISTORY 
 

 
Click [Robot] on the menu bar and click [Error History] on the pull-down menu. Error history for the 
connected robot is read out and displayed. 
Error history shows the history for up to 1000 errors. 
 

NOTE 
You can copy the contents of the error history to the clipboard by selecting [Copy] on the dialog. 
The text copied onto the clipboard can be pasted onto applications such as Microsoft Word® etc.  
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18. DATA PRINT-OUT 
 

 
You can output C & T Data to your printer. 
 

 

 
Click [Print Preview] to confirm the printing image. If you want to print out a particular program or point 
job, locate the page numbers using the print preview and then set the page numbers in the print dialog 
box. 
 
Click [Print Setup] to change the printer settings. 
 
 
  

Click [File] on the menu bar and click [Print] on the 
pull-down menu. 
The “Setting of Print Item” dialog box is displayed. 
Select the item you want to print and click [OK]. 
You can select all of the C & T data (the 
aforementioned data unit) by setting the print range to 
[Select All]. 
 
Click [OK] on the print confirmation dialog box to start 
printing. 
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19. POINT GRAPHIC EDITOR 
 

 
With Point Graphic Editor, path data can be created and edited graphically as a diagram. 
Path generation is easy to understand and can be done simply by creating it based on a DXF file made 
in CAD software, or Gerber format data displayed in the support layer used by printed circuit board 
(PCB) industry software. 
Also, you can use image data (JPEG) taken by a digital camera, display it in the background, and refer 
to it while editing the path. 
 
Point Graphic Editor displays and edits the point row data of the program currently open. 
If you start up Point Graphic Editor as shown below, you can edit program number 2. 
 

 
 
 
19.1 Start Up and Exit 

19.1.1 Start Up 
Select [Edit] from the menu bar and select [Edit Graphic Point] on the pull-down menu. You can also 
start it up from the tool bar button. 
 
19.1.2 Exit 
To exit Point Graphic Editor, on the Point Graphic Editor menu bar select [File] and click [End 

Point-Graphic Editor]. You can also click the  icon on the top right of the screen to exit or double 
click the  icon at the top left of the screen. 
 
19.2 Procedure for Standard Operations 
This section explains how to operate Point Graphic Editor through a series of operations. 
 
19.2.1 Editing Mode Selections 
From the menu or tool bar turn Edit Trajectory ON.  
(Further details regarding Edit Trajectory are later in the section) 
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19.2.2 Graphic Placement – Movement 
With this function you can place 4 types of graphics: Point, Straight Line, Ellipse, and Arc.  
Straight lines and arcs can be linked with other graphics; however points and circles are positioned 
independently. When you want to place a graphic, select the graphic from the menu or the tool bar. 
Additionally, if you want to move or resize a positioned graphic, select the graphic from the menu again 
or click the selection button from the tool bar to switch to the select/move mode. 

 

(From the left: edit button, point button, straight line button, ellipse button, ellipse by center point button, 
arc button, auto arc button, and path order settings button). 
 
Examples of placing all of the graphic types: 
 
 Point Placement 
Click the point button to enter the point button positioning mode. 
A point is placed by clicking the area where you want to position the point on the coordinate’s grid. 

 
 
 Straight Line Placement 
This places a straight line. Click the straight line button to enter the straight line positioning mode. 
A straight line is placed by clicking a start point and an end point, in that order. 
 

 
 
 Ellipse Placement 
Click the ellipse button to enter the ellipse mode. Position the circle by clicking 2 points, a start point 
and a diameter point (support point) that links to the start point. The circle is placed on the diameter of 
the start point and the support point. 
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 Ellipse by Center Point Placement 
Click the ellipse by center point button to enter the ellipse by center point mode. Place the ellipse by 
clicking two points: a start point and a center point. A support point, following a direct line from the start 
point and center point, positions the circle.  

 
 
 Arc Placement 
Click the arc button to enter the arc mode. Click the three points in the order of start point, end point 
and support point. An arc joining the start point – support point – end point is positioned. 

 

 
 Colors of the Various Points 
The colors of the various points show the start and end of the robot’s path. 
Purple: independent point (PTP Point) 
Light blue: start point (CP Start Point) 
Light red: end point (CP End Point) 
Green: passing point (CP Passing Point) 
Yellow: arc support point (CP Arc Point) 
For details regarding the color of trajectory line points, please refer to “19.3.3 Edit View.” 
 
 Snap Function and Coupling 
The snap function allows you to easily draw a consecutive path for the robot. When you are deciding 
on each point’s location, move the mouse close to points already placed or corners of the grid lines to 
snap the points into place. By deciding on point locations with this function, you can place points with 
the same coordinates as points already positioned or to the same coordinates as grid line corners. 
 
You can snap all existing points; however, points can only be linked consecutively, basically, when you 
place and snap start points to end points which are already positioned. 
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If you want an end point consecutively linked to a start point that is already positioned, select the start 
point items and snap it to the end point to make a consecutive link. 
 

 

Also, if you want to cancel a consecutive point, select the consecutive item (the item that will be on the 
end point side after canceling the consecutive point) in the preceding sequence within the 
consecutively linked item. Move the point and by snapping it back into place you can have the same 
point no longer linked consecutively. 
 

 
If you do not want to snap points into place, hold down both the Ctrl key and the Shift key when moving 
and placing points. 
 
 
 When you want to place a circle that continues on from another graphic. 
As previously mentioned, a circle graphic cannot be linked consecutively with another graphic. If you 
want to consecutively link a circle with another graphic, use an arc. By placing two arcs with a central 
angle of 180 degrees, you can place a whole circle. 
 
When placing the arc point (the third point), hold down the Ctrl key. If you hold the Ctrl key, the arc is 
fixed with a central angle of 180 degrees.  
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 Moving Points and Items 
You can move graphics already positioned. Place the mouse cursor over the item you want to move 
and move it by dragging and dropping it. When you want to move the whole item, click and drag with 
the cursor on the line, and when you want to move only a point, click and drag with the cursor on the 
point. When you move an item, the points connected do not follow. 

 
 
 
 Selecting Items and Moving Multiple Points and Items 
Click the edit button and in the edit mode click the item you want to select, or by creating and dragging 
the range you want with the mouse, you can select items. 
Additionally, if you double click an item, the consecutively linked items can be selected all at once.  
(If selecting by range, when all of the points that make up a given graphic are within the range, the 
items are selected. For a circle or an arc graphic, you do not need to include the whole graphic within 
the range.) 
 
When multiple items are selected, you can move the entire set of items by using the mouse to drag 
and drop the lines or by using the arrow keys on the keyboard. 
 
Additionally, if selecting by using a range, you can also select items for which the editing function is 
OFF at the same time. (If trajectory lines are ON, you can also select auxiliary lines and the imported 
figure.) 
If you only want to select trajectory lines (editable items only), hold the Shift key and a drag out the 
range you want.  
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Before Selection 

 
 
After Selection 

 
 
Select by mouse drag only  all items within the range are selected 
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Selection by dragging the mouse with the Shift key  Only editable items are selected 

 
 
 
 Modifying the Sequence Through Insertion 
Graphics positioned using this function start at the home point and are made up of one type of line. 
Newly created graphics are generally at the end of the sequence. 
When creating new graphics or by moving and snapping graphics into place, the sequence order 
changes if these are consecutively linked to existing items. 
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 Reverse Start/End Point Function 
By pushing the Reverse Start/End Point Function button on the tool bar when an item is selected, you 
can reverse the item’s start point and end point. Points and circles do not have start points and end 
points therefore they cannot be reversed. 
By selecting and reversing the whole item of a consecutively linked item, you can reverse the start 
point and end points while preserving the consecutive sequence. 
 

 
 
 
 Path Order Function 
The Path Order Settings button is a function for changing the path sequence for a group of items. Push 
the Path Order Settings button to enter the path order function.  
Buttons of the current sequence are displayed on the screen at the various start point positions, as 
shown in the diagram on the next page. 
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The sequence up until the first button pushed is fixed, and the path sequence changes according to 
the order in which the subsequent buttons are pushed after this. 
 
For example, if you want to change the sequence from the first number, click the numbers “0  an 
arbitrary number”. Once fixed, the buttons can no longer be selected. 
 
If you want to switch only graphics 3 and 4 in the above diagram, select number 2, the number directly 
before the first diagram you want to switch. By doing this, numbers 0, 1, 2 are no longer selectable. 
After this, by clicking 4  3 on this screen the sequence changes. This method is enabled when you 
want to change only some of the path within a sequence of various paths. 
 
Once you finish changing the sequence, the software returns to the Edit Mode etc. 
 
 
 Edit Trajectory Mode and Edit Auxiliary Line Mode 
With this program you can edit “trajectory lines” and “auxiliary lines”. Trajectory lines are registered 
graphics that are added to point row data and are sent to the robot by the sending of C & T data. 
Auxiliary lines are a mode for drawing support graphics for trajectory line drawing. Auxiliary lines are 
not sent to the robot.  
 
You can switch to Edit Trajectory Mode or Edit Auxiliary Line Mode from the tool bar or menu. 

  
Edit Trajectory Mode is on the left, and Edit Auxiliary Line Mode is on the right 
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Also, you can change the displays for both trajectory lines and auxiliary lines. The movement line 
(offline) display and grid line display can be switched ON and OFF. 
 

 

(From the left) 
Grid line display 
Trajectory line display 
Auxiliary line display 
Import figure display 
Offline display 
 
 
19.3 User Interface 
This section explains the Point Graphic Editor’s main UI.  
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The UI is made up of 4 main items. 
 
• Menu bar 
• Tool bar 
• Editing view 
• Status bar 
 
 Menu Bar 
Please refer to “19.3.1 Menu Bar”. 
 
 Tool Bar 
Please refer to “19.3.2 Tool Bar”. 
 
 Editing View 
Please refer to “19.3.3 Edit View”. 
 
 Status Bar 
This displays the cursor’s position information and the current display screen zoom percentage. 
 

 

 
 
19.3.1 Menu Bar 
You can use all the functions from the menu bar. 

 

 
 File Menu 
Import DXF File : Converts and loads a DXF file into JR C-Points II data 
Import Gerber Data File : Converts and loads a Gerber data file into JR C-Points II 

data 
Clear Imported Figure : Clears imported figure 
Background Image Settings : Loads a JPG file as a background image 
Clear Background Image : Clears the background image 
Page Setting : Opens the page setting dialog 
End Point Graphic Editor : Exits Point Graphic Editor 
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 Edit Menu 
Cut : Cuts the selected graphic 
Copy : Copies the selected graphic 
Paste : Pastes the cut/copied graphic 
Delete : Deletes the selected graphic 
Undo : Undoes the operation. Only works with graphic creation, 

movement, deletion, and sequence change operations. Also, 
the operation history is cleared when you import a file 

Redo : Redoes the operation. Only works with graphic creation, 
movement, deletion, and sequence change operations. Also, 
the operation history is cleared when you import a file 

Select All* : Selects all graphics 
 
* After selecting all graphics, if you want to remove the work home position from the selection, select 

the select/move button (the leftmost button) from the tool bar below and click on the work home 
position whilst holding down either the Ctrl key or Shift key on the keyboard. 

 
 
 Display Menu 
Zoom In : Zooms in the edit view 
Zoom Out : Zooms out the edit view 
Zoom (50% – 400%) : Changes the edit view to the selected zoom percentage 
Display Entire Window : Changes the zoom percentage to display the entire the edit 

view area 
Arbitrary Zoom 
(10% – 40,000%) 

: Opens the zoom percentage dialog and from here you can 
change the edit view to an arbitrary zoom percentage 

Display Grid : Turns the grid lines ON/OFF 
Grid Interval Setting 
(0.01mm – 100mm) 

: Sets the grid intervals 
Also, you can select whether or not to snap objects to the 
corners of the grid 

Display Trajectory : Turns the trajectory line display ON/OFF 
Display Auxiliary Line : Turns the auxiliary line display ON/OFF 
Display Import Graphic : Switches between displaying/hiding the import graphic 
Show Offline : Switches between displaying/hiding the robot’s offline 

movements 
Show Point Number : Switches between displaying/hiding the point numbers 
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 Graphic Menu 
Edit Trajectory : Turns the Trajectory Edit Mode ON/OFF 

When Trajectory Edit Mode is turned ON, Auxiliary Line Edit 
Mode is turned OFF 

Edit Auxiliary Line : Turns the Auxiliary Line Edit Mode ON/OFF 
When Auxiliary Line Edit Mode is turned ON, Trajectory Edit 
Mode is turned OFF 

Select/Move : Selects the Select/Move Mode 
Point : Selects the Point Creation Mode 
Straight Line : Selects the Straight Line Creation Mode 
Circle : Selects the Circle Creation Mode 
Circle-by-Center : Selects the Circle and Circle Center Point Creation Mode 
Arc : Selects the Arc Creation Mode 
Create Auto Arc : Selects the Auto Arc Creation Mode 
Path Order Setting : Selects the Path Order Setting Mode 
Start Point End Point Reverse : Reverses the start point and end point of the selected 

graphic. This function can only be used when an editable 
graphic is selected 

Previous Item : Moves you to the item immediately before the currently 
selected item in the trajectory sequence. This function is only 
valid in Trajectory Edit Mode 

Next Item : Moves you to the item immediately after the currently 
selected item in the trajectory sequence. This function is only 
valid in Trajectory Edit Mode 

Graphic Properties : Opens the graphic properties dialog 
 
 
 Tool Menu 
Create Graphic : Opens the graphic creation dialog, and from here you can 

create graphics using numerical input 
Edit Graphic : Opens the graphic editing dialog, and from here you can edit 

the graphic’s information 
Move Graphic : Opens the graphic displacement dialog, and from here you 

can arbitrarily change the relative position of the graphic from 
the current one 

Coordinate Conversion : Opens the coordinate conversion dialog, and from here you 
can convert coordinates for the given line types 

Auto Connect : Automatically connects all possible consecutive items in the 
sequence towards the end point from the selected item. 
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Sort by Direction : Opens the sort by direction dialog, and from here you can 
change the path order from the various selections 

Create Circle by Designated 
Radius 

 Opens the create circle by designated radius dialog, and 
from here you can create a circle centered around the 
selected point graphic 

Create Circle by Intermediate 
Radius 

: Select two circles, and then use this to create a circle 
centered between the two circle’s center points and the 
average diameter 

Create Circle/Arc Center Point : Places a point graphic at the circle/arc center point position 
of the selected graphic 

Create Line in Rectangle 
Center 

: Places a straight line in between the two longest lines of the 
selected graphic. 

 
 
19.3.2 Tool Bar 
You can use each of the various functions from the tool bar. 
 
 Tool Bar 1 

 

(From the left) 
Page Settings : Opens the page setting dialog 
Cut : Cuts the selected graphic 
Copy : Copies the selected graphic 
Paste : Pastes the cut/copied graphic 
Delete : Deletes the selected graphic 
Undo : Undoes the operation. Only works with graphic creation, 

movement, deletion, and sequence change operations. Also, 
the operation history is cleared when you import a file 

Redo : Redoes the operation. Only works with graphic creation, 
movement, deletion, and sequence change operations. Also, 
the operation history is cleared when you import a file 

Zoom In : Zooms in the edit view 
Zoom Out : Zooms out the edit view 
Zoom : Opens the zoom percentage dialog and from here you can 

change the edit view to an arbitrary zoom percentage 
Display Grid : Turns the grid lines ON/OFF 
Display Trajectory : Turns the trajectory display ON/OFF 
Display Auxiliary Line : Turns the auxiliary line display ON/OFF 
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Display Import Figure : Switches between displaying/hiding the import figure 
Display Offline : Switches between displaying/hiding the robot’s offline 

movements 
 
 
 Tool Bar 2 

 

(From the left) 
Edit Trajectory : Turns the Trajectory Edit Mode ON/OFF 

When Trajectory Edit Mode is turned ON, Auxiliary Line Edit 
Mode is turned OFF 

Edit Auxiliary Line : Turns the Auxiliary Line Edit Mode ON/OFF 
When Auxiliary Line Edit Mode is turned ON, Trajectory Edit 
Mode is turned OFF 

Select/Move : Sets the Edit Mode to Select/Move Mode 
Point : Sets the Edit Mode to Point Creation Mode 
Straight Line : Sets the Edit Mode to Straight Line Creation Mode 
Ellipse : Sets the Edit Mode to Circle Creation Mode 
Ellipse by Center Point : Sets the Edit Mode to Circle and Circle Center Point Creation 

Mode 
Arc : Sets the Edit Mode to Arc Creation Mode 
Create Auto Arc : Sets the Edit Mode to Auto Arc Creation Mode 
Path Order Setting : Sets the Edit Mode to Path Order Setting Mode 
Reverse Start/End Point  : Reverses the start point and end point of the selected 

graphic. This function can only be used when an editable 
graphic is selected 

Previous Item : Moves you to the item immediately before the currently 
selected item in the trajectory sequence. This function is only 
valid in Trajectory Edit Mode 

Next Item : Moves you to the item immediately after the currently 
selected item in the trajectory sequence. This function is only 
valid in Trajectory Edit Mode 

Graphic Properties : Opens the graphic properties dialog 
 
  

98 



PC Operation Desktop Robot JR3000 

19.3.3 Edit View 
This section explains the items that appear in the edit view. 
 

 
 
 Ruler 
There is a guide ruler along the top and left of the edit view. The measurement units are mm.  
By default the horizontal axis is the Y axis and the vertical axis is the X axis. You can change this from 
the menu [File]  [Page Setting].  
(If you want to change the horizontal axis, you must do so during project creation.) 
 
 Work Area 
The white background area is the work area. You can change the size of the work area from the menu 
[File]  [Page Setting]. 
 
 Grid Lines 
Grid lines to guide editing are displayed on the work area. You can turn these ON/OFF from the tool 
bar or the menu [Display]  [Display Grid]. 
For grid line spacing, you can change this from the menu [Display]  [Grid Interval Setting]. 
If the grid spacing is too narrow and the current zoom ratio cannot display the grid, the grid lines are 
not displayed. 
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 Trajectory, Auxiliary Line, Imported Figure, and Offline (movement lines) 
Graphics edited (or graphics shown) in the edit view are as follows: 
 

 
(Black: solid lines) 
These represent the trajectory movements of the robot. This data is sent to the robot. 
When Trajectory Edit Mode is ON, these lines appears as the above thickness, however, when 
Trajectory Edit Mode is OFF, these appear as thin lines. You can turn the trajectory display OFF/ON 
with the “Display Trajectory” function. 
 

 

(Yellow: solid lines) 
These represent auxiliary lines for guiding editing operations. This data is sent to the robot. 
When Auxiliary Line Edit Mode is ON, these lines appear with the thickness shown above; however, 
when Auxiliary Line Edit Mode is OFF, these appear as thin lines. You can turn the auxiliary line display 
OFF/ON with the “Display Auxiliary Line” function. 
 

 

(Gray: dotted lines) 
These represent the trajectory movements of the robot; however, the robot’s tip is raised. This data is 
sent to the robot. However, you cannot directly edit these lines. By modifying trajectories, these are 
automatically changed. 
You can display these movements ON/OFF with the “Show Offline” function. 
 

 
(Blue: solid lines) 
These represent imported external data (an imported figure). These cannot be edited, however, when 
creating trajectories/auxiliary lines these can be snapped to the imported figure. Also, these can be 
copied, and pasted as trajectories or auxiliary lines. 
You can display these lines ON/OFF with the “Display Import Graphic” function. 
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 Trajectory Point Colors 
The trajectories’ various points are color coded as follows: 
 

 

(Purple) represents a PTP point. 
 

 

(Light blue) represents a CP start point. 
 

 

(Red) represents a CP end point. 
 

 

(Yellow) represents an arc point. 
 

 

(Green) represents a CP passing point. 
 

 
(White) represents a circle assist point. This is an assistant point only for Point Graphic Editor 
 

 
(Clear) represents a circle center point 
 

 
(Gray) represents a point with a broken point link. 
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 Dispense Filling Points 
Dispense filling points cannot be newly positioned or set in Point Graphic Editor. Only coordinate 
editing can be done in Point Graphic Editor 
 

NOTE 
Dispense filling points are useable only with Dispensing Specifications. 

 
The dispensing area is represented by a rectangle or circle enclosed by the specialized points. 
 

 
(Magenta: rectangle) this represents the work area enclosed by a trajectory zigzag start point and a 
rectangle end point. 
(Orange: rectangle) this represents the work enclosed by an auxiliary line zigzag start point and a 
rectangle end point. 
 
 

 

(Indigo: rectangle) this represents the work area enclosed by a trajectory rectangular spiral start point 
and a rectangle end point.  
(Yellow: rectangle) this represents the work area enclosed by an auxiliary line rectangular spiral start 
point and a rectangle end point. 
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(Indigo: circle) This represents the work area enclosed by three trajectory points: a spiral start point, 
circumference of spiral area 1, and circumference of spiral area 2. 
(Yellow: circle) This represents the work area enclosed by three auxiliary line points: a spiral start point, 
circumference of spiral area 1, and circumference of spiral area 2. 
 
 
19.4 Graphic Editing 
 Overview 
The items that can be placed are points, straight lines (consecutive straight lines), circles, or arcs. Each 
item is made up of all, or a combination of start points, end points, or support points. 
Each start point, end point, or support point is a part of an item’s configuration and differ from the 
function of a Point. 
 
The selected/unselected statuses of the items are as follows: 
 Unselected Selected 

Point   
Line   

 
 Placement Rules 
When placing each item, select the item to be placed from either the menu or tool bar. Items are placed 
in this order: start point  end point  support point. 
(Depending on the item there are some points which are not used. Refer to the table below). 

 Start 
Point 

End 
Point 

Support 
Point Reference 

Point    The starting point is the placed point. 
Straight 

line    A straight line connecting the start point and end point is drawn. 

Circle    

For a circle graphic, the placement methods are either of the 
following: 
A circle with a diameter of the start point and the support point is 
drawn. 
A circle with a radius of the start point and circle center point is 
drawn. 

Arc    An arc connecting the start point  support point  end point is 
drawn. 
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• Key operations and combinations for placing items 
You can manage the placement of items with the following key and mouse combinations: 

 Ctrl Key Shift Key Ctrl + Shift Key 
Point N/A N/A No snapping 

Straight 
Line 

When placing the end point, the position from 
the start point is rounded to a 45° angle. N/A No snapping 

Circle 
When placing the support point (or circle 
center point), the position from the start point 
is rounded to a 45° angle. 

N/A No snapping 

Arc 

When placing the end point, the position from 
the start point is rounded to a 45° angle 
When placing the arc point, the center angle 
is rounded to a 180° angle. 

N/A No snapping 

 
 
 Movement Rules/Apex Movement Rules 
You can move the items by dragging them with the left mouse button. The position of the item’s 
movement is set when you click and release the mouse button. 
 
If you drag a point within an item (start point, end point etc.), only that point moves and the graphic’s 
shape (size) changes.  
 
If you drag an item’s line (a line connecting various points), the whole item is moved. Also, if multiple 
items are selected, all of the selected items are moved. 
 
• Key operations and combinations for moving items 
You can manage the placement of items with the following key and mouse combinations: 

 Ctrl Key Shift Key Ctrl + Shift Key 
Point N/A N/A No snapping 

Straight 
Line 

When moving a point, the angle 
with the unmoved point is fixed. 

When moving a point, 
the distance with the 
other point is fixed. 

No snapping 

Circle 

• When moving the start point, 
the angle with the support 
point is fixed. 

• When moving the center 
point/support point, the angle 
with the start point is fixed. 

When moving the start 
point/support point, the 
center point is fixed 
(only when moving the 
support point). 

No snapping 

Arc 

When moving the start point (end 
point), the angle with the end 
point (start point) is fixed at the 
time of placement. 
When placing the arc point, the 
central angle is fixed at 180°. 

When moving the arc 
point, the center point 
is fixed. 

No snapping 
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 Delete 
Select the graphic you want to delete, and then select Edit  Delete on the menu bar, or press the 
Delete key to delete the graphic. 
 
 Movement Example 
Below is an example of actual movement operations. 

 
 Snap function and consecutively linking items (Path Generation) 
With the snap function you can consecutively link an item’s start point to a different graphic’s end point. 
(However, you can only do this with end points that are not already consecutively linked). The points 
connected become consecutive points and these two items become part of the same path. You cannot 
split the path; therefore, the consecutive link is made up of these two items. 
(It is possible to have multiple passing points, start points and end points at the same coordinates).  

Selected 

Item movement (line movement) 

Item resizing (with a point) 

Path movement/selecting multiple items 

Unselected 

Moving a passing point while keeping the item consecutively linked 
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Point you are snapping Point it is snapped to Outcome 
Start point End point Consecutively linked 
End point Start point Not consecutively linked 
Start point Start point Not consecutively linked 
End point End point Not consecutively linked 

 
• Rules for consecutively linking/removing consecutive links 
Generally if you want to make a consecutive link, you can do this by snapping a start point to any given 
end point you want to link with consecutively. Conversely, if you want remove a consecutive link; select 
the end point in the consecutively linked item, move the end point to remove the consecutive link, and 
snap it back to the same point. By doing this, the end point is being snapped to the start point and 
therefore is no longer consecutively linked (the consecutive link is removed). 
As an exception to snapping an end point and consecutively linking a start point, if you place a new 
graphic in between the two graphics you want to consecutively link, you can consecutively snap both 
the start point and end point. 
 
 Rules for changing the sequence 
If items are consecutively linked, the order of the item in the robot’s trajectory sequence may change. 
Only the order of the moved item will change. If you want to change the sequence of the path units, 
use the aforementioned path order function. 
 
• Operation Example 

 
 
  

Start point End point Passing point Subject of editing 
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• Placing New Items 

 

• Editing and Moving Items 

 

Place the item without snapping it to anything  it is placed at the end of the sequence 

The end point is snapped to a start point  it is placed at the end of the sequence (the 
sequence does not change). 

Snap the start point to an end point  it comes after the item it was snapped to and it is 
consecutively linked. 
 

Snap items so they are connected  insert the item; both the start point and end point 
become consecutively linked. 

Move the item without snapping it to anything  the sequence does not change 

Snap the start point to an end point  it comes after the item it was snapped to and it is 
consecutively linked. 

Snap the end point to a start point  it is not consecutive and the sequence does not change. 
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• Consecutively Linking Items/Removing a Consecutive Link 

 

 
 Path Order Function 
You can change the path’s sequence with the path order function. (You cannot change the sequence 
within the path). 
From the menu or the tool bar, select the path order function to display buttons with numbers showing 
the order at the start point positions (CP start points in the JCS format) from among trajectory items 
already placed. The sequence is set in the order you push the buttons. The first button you push 
means that the sequence up until that button does not change. The sequence changes from the 
second button onwards that you push. The path order function is finished when you select another 
mode, therefore you do not need to continue pushing the buttons to the end. 
 
• Example of operation procedure 
Example 1: With the current numbers, you want to switch the sequence to 4  3  2  1. 
 With the current display, push the buttons in this order 0  4  3  2  1. 

 
NOTE 
Each time you press a button the displayed numbers change. 

 

 
  

Remove the consecutive link  use the item on the preceding side of the link, temporarily 
move it to different coordinates and snap it back into place. 

Consecutively link unconnected items  use the item on the latter side of the link, temporarily 
move it to different coordinates and snap it back into place. 
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Example 2: With the current numbers, you want to switch only 34 and 35. 
 With the current display, press the numbers in this order 33  35  34. 

 
NOTE 
Each time you press a button the displayed numbers change. 

 

 
 
 Selection Operations and Selectable Items 
With this application you can select items with the two following main selection operations: 
 
• Selection by mouse click 
• Selection by mouse drag 
 
1. Selection by mouse click 
Selection by mouse click is limited to editable items. By using Shift key/Ctrl key combinations you can 
select multiple items. 
Also, if you select an item by double clicking it, the clicked item and all items connected to that item are 
selected. 
 

Selection Keyboard Outcome 

Editable Item N/A The clicked item is selected (all other items are 
unselected) 

Editable item +Ctrl The clicked item switches to the selected state 
Editable item +Shift The clicked item switches to the selected state 
All other areas N/A All items are unselected 
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2. Selection by mouse drag 
When you make a selection by dragging the mouse, non-editable items can be selected. Also, you can 
select only editable items by using a Shift key combination. 

Selection Keyboard Outcome 

All displayed items N/A The items within the range created by dragging the 
mouse are selected. 

Editable items +Shift The editable items within the range created by 
dragging the mouse are selected. 

 
 
 Reverse Start/End Point Function 
You can reverse the start point and end point of an item with the reverse start/end point function. 
Select the item you want to reverse and from the menu or tool bar select the reverse start/end point 
function to reverse the start point and end point of the selected item. 
By performing a reversing operation with the whole path selected, you can reverse that path’s start 
point and end point. 
 
Example 1: Reversing the start point and end point of individual items 
 Select the individual items or part of the path, and reverse the start point and end point. 
The start point and end point of the selected items are reversed. Consecutively linked items are no 
longer linked. 

 
 
Example 2: Reversing the start point and end point of an entire path 
 Select all of the items included in the path, and reverse the start point and end point. 
The path stays consecutively linked and the start point and end point are reversed. 
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 Create Auto Arc Function 
When the Create Auto Arc function is selected from the tool bar, click a consecutive point and the 
Create Auto Arc dialog is displayed. 

 
 
• Settable Items 
Radius 
 
Specify the arc’s diameter to create it automatically. 
An arc is created automatically so that the two lines connected to the consecutive point are inscribed 
as an arc.  

 

If you hold down the Ctrl key and click a continuous point, an arc is created using the previously set 
radius without the Create Auto Arc dialog appearing. 
 
 
19.4.1 Create Graphic/Edit Graphic Dialog 
You can create/edit graphics from the Create Graphic/Edit Graphic dialog. 
 
This dialog is displayed when you chose Create Graphic or Edit Graphic. 
When creating, select the tab of the graphic you want to create, and enter the arbitrary values to create 
the graphic. 
When editing, the tab of the object you are editing is enabled. 
 
• Tabs 
Point 
Straight Line 
Circle (Diameter) 
Circle (Center) 
Arc  

 

 

a 

d 

a 

b c e 
f c 
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 Creating/Assigning a Point 

 

• Settable Items 
Position (X, Y) 
 
An individual point is created or edited on the position (X, Y) 
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 Creating/Assigning a Straight Line 

 

• Settable Items 
Start Point (X, Y) 
End Point (X, Y) 
 
A straight line (line segment) connecting the start point and end point is created or edited. 
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 Creating/Assigning a Circle (Diameter) 

 

• Settable Items 
Start Point (X, Y) 
Passing Point (X, Y) 
 
A circle with the diameter of the start point and the passing point is created or edited. 
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 Creating/Assigning a Circle (Center) 

 

• Settable Items 
Start Point (X, Y) 
Center Point (X, Y) 
 
A circle with center point as the center of the circle is created or edited by using the start point and the 
center point as the diameter.  
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 Creating/Assigning an Arc 

 

• Settable Items 
Start Point (X, Y) 
End Point (X, Y) 
Arc Point (X, Y) 
 
An arc joining the start point – arc point – end point is created or edited.  
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19.4.2 Graphic Displacement Dialog 
You can move a graphic from the Graphic Displacement dialog. 
 
Select the graphic you want to move, and by selecting [Tool] [Move Graphic], the Graphic 
Displacement Dialog appears. 
 

  
 
Set the amount to move the graphic from the current position, and click the OK button to move the 
graphic from the current position by that specified amount. 
 
 
19.4.3 Coordinate Conversion 
You can change the coordinates of a positioned item with the coordinate conversion function. 
 
 Operation Procedure 
From [Tool] on the menu bar select [Coordinate Conversion]. 
 
The Coordinate Conversion dialog is displayed. Enter the type and coordinate conversion settings and 
click the OK button to perform the conversion. Select “Convert by designated coordinates...” to 
calculate the conversion data from entering values into the robot’s coordinate system and the 
corresponding editing view coordinates. (Further details follow). 
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• Settable Items 
Convert Trajectory Line Coordinates : Designate whether to target the trajectories for conversion. 
Convert Home : Designate whether to target the home position for 

conversion. 
Convert Auxiliary Line Coordinates : Designate whether to target the auxiliary lines for 

conversion. 
Converted Imported Line Coordinates : Designate whether to target the imported figure for 

conversion. 
Offset Value : Specify the additional offset for conversion. 
Conversion Center Position : Specify the rotation’s center or the reference point for 

enlargement/reduction. 
Rotation Angle : Specify the angle of rotation for conversion. 
Scale : Specify the scale for conversion. 
 
If you select trajectory lines as a target of conversion, all trajectories are targeted, and if you select 
auxiliary lines as a target of conversion, all auxiliary lines are targeted. Therefore you cannot convert 
only “some” of the trajectory lines etc.  
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 Convert by Designated Coordinates 
When you load an external graphic into the edit view, the position coordinates in the edit view and the 
position coordinates of the actual item on the robot sometimes do not match. To match the coordinates 
to the actual coordinates of the robot, use the Convert by Designated Coordinates function. 
 

 
 
By designating the two robot reference points, P1 and P2, and the edit view’s corresponding reference 
points, p1 and p2, each setting value is automatically calculated to matchup the robot coordinate 
system’s reference points, P1 (X1 and X2) and P2 (X2 and Y2) and the edit view’s reference points, p1 
(x1 and y1) and p2 (x2 and y2).  
  
 
  

Robot Coordinate System Point Graphic Edit View 
Coordinate  
Conversion 
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• Settable Items 
Robot Coordinate System : These two reference points are for specifying the position after 

coordinate conversion. 
Edit View Coordinates : These two reference points are for specifying the position before the 

coordinate conversion. 
 
If you display the Coordinate Conversion dialog, a straight red line linking the two points of the robot 
system coordinates and a straight blue line linking the two points of the edit view coordinates appear in 
the edit view. 
Also, when you click on the edit view when the Coordinate Conversion dialog is open, you can set 
coordinates to the item which is selected by the radio button by clicking on coordinates in the edit view.  
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After setting the coordinates, click the OK button to automatically set the offset values, the conversion 
center point, the rotation angle and the expansion/contraction scale. 
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19.4.4 Using the Graphic Creation Function with an Existing Graphic 
With Point Graphic Editor, there are functions to “place” or “assign” new graphics using existing 
graphics you have created. These functions can be executed from these menus: 
 
• [Tool] – [Create Circle by Designated Radius] 
• [Tool] – [Create Circle by Intermediate Radius] 
• [Tool] – [Create Circle/Arc Center Point] 
• [Tool] – [Create Line in Rectangle Center] 
 
 Create Circle by Designated Radius 
This creates a circle of a designated radius centered on the selected point (independent point). If there 
are multiple points within the selected graphic, multiple circles are created. If there are no points, a 
graphic is not created. 
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 Create Circle by Intermediate Radius 
A circle with an average position between two circles (a center point positioned in between the two 
circles) and with an average size (the average radius of the two circles) is created between the 
selected graphics. If there are 3 or more circles, the circle is created using the information from the two 
circles found first. If the number of selected circular graphics is one or less, the graphic is not created. 
This is a useful function for placing a circle in between two concentric circles of different sizes.  
 

NOTE 
The order that the circles are found varies depending on the trajectory line order or auxiliary line 
order; however, in general, the order cannot be known from appearance alone. 

 

 
 
 Create Circle/Arc Center Point 
This creates a circle center point for the selected circle/arc. If there are multiple circles/arcs within the 
selected graphic, you can select whether to create points closer than 0.1mm or not. If there are no 
circles/arcs within the selected graphic, no graphics are created.  
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 Create Line in Rectangle Center 
With this application, the idea of a rectangle does not exist; however, there is a function to place a 
straight line in the middle of a combination of multiple straight lines that have the appearance of a 
rectangle. If the selected graphic has more than two straight lines, a straight line is placed in between 
the two longest lines. If there are 1 or fewer straight lines, this graphic is not created. This is a useful 
function for placing a line in between a rectangle, etc. 
 

NOTE 
If there are multiple lines with the same lengths, the lines found first are selected. The order that the 
lines are found varies depending on the trajectory line order or auxiliary line order; however, in 
general, the order cannot be known by external appearance alone. 
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19.4.5 Auto Connect 
 Function for automatically connecting a selected graphic 
With a graphic selected, execute [Auto Connect] from the [Tool] menu to automatically connect all 
possible consecutive items in the sequence towards the end point. 
 
Auto Connect Conditions 
The source end point of the 
consecutive item has a start 
point/end point with the same 
coordinates. 

The point found is a start point and the item on the start point 
side is not already consecutive 
The point found is an end point and the item on both the start 
point and end point side is not already consecutive 

 
If the above conditions are met, the graphic is automatically connected as follows: 
If linking a start point, the items are consecutively linked with no change. 
If linking an end point, reverse the start point and end point and then perform auto connect. 

 
Example: 

 

 

 

 

 
  

Caution 
 

With a graphic such as the one below where the CP Start Point and 
CP End Point have the same coordinates, if you select and execute 
auto connect on a line other than the CP Start Point, all the points 
become CP Passing Points. 
Change the point to a CP Start Point and/or CP End Point in the 
point row on the main screen. 
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19.4.6 Sort by Direction Dialog 
If you select [Sort by Direction] from the [Tool] menu when multiple paths are selected, you can switch 
the order of the multiple paths. 

 
• Settable Items 
Bottom to top 
Top to bottom 
Right to left 
Left to right 
The paths are sorted from the direction specified from the start point. 
 
Examples for sorting various paths 
Example of sorting paths by specifying the “Left to right” sort direction: 
Before sorting After sorting 

 

Example of sorting paths by specifying the “Top to bottom” sort direction: 
Before sorting After sorting 
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19.5 Loading a Background Image 
You can load a JPG image as a background image.  
 
 Operation Procedure 
• Select [Menu] – [Background Image Setting]. 
• The background image setting dialog appears. Select the JPG file to load as the background, after 

it is loaded, set the display position for the image, and click the OK button to load the image as the 
background. Select “convert by designated coordinates”, enter the robot’s coordinate system and 
the conversion data is calculated (details to follow).  

127 



PC Operation Desktop Robot JR3000 

In addition, if you load the image using the default values, the reference point of the loaded position is 
treated as 0,0 regardless of the coordinate system settings, and the image is loaded using the 
Windows coordinate system (horizontal axis is X/vertical axis is Y, the right direction is positive, and the 
down direction is positive). 
 

 
 
• Settable Items 
Background Image File Name : From the file selection dialog, specify the image file to 

display as the background. 
Offset Position : Specify the offset position for loading the image. 
Conversion Center Position : Specify the rotation’s center or the reference point for the 

enlargement/reduction. 
Rotation Angle : Specify the rotation angle for loading the image. 
Set Display Magnification : Specify the zoom percentage for loading the image. 
Transmission : Specify the transparency ratio of the background image 
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 Convert by Designated Coordinates 
When you load an external graphic into the edit view, the position coordinates in the edit view and the 
position coordinates of the actual item on the robot sometimes do not match. To match the coordinates 
to the actual coordinates of the robot, use the Convert By Designated Coordinates function. 
 

 
 
By designating the two robot reference points, P1 and P2, and the edit view’s corresponding reference 
points, p1 and p2, each setting value is automatically calculated to matchup the robot coordinate 
system’s reference points, P1 (X1 and X2) and P2 (X2 and Y2) and the edit view’s reference points, p1 
(x1 and y1) and p2 (x2 and y2).  
 

  

Robot Coordinate System Point Graphic Edit View 
Coordinate  
Conversion 
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• Settable Items 
Robot Coordinate System : These two points are a reference for specifying the position after 

coordinate conversion. 
Edit View Coordinates : These two points are a reference for specifying the position before 

coordinate conversion. 
 
If you display the Coordinate Conversion dialog, a straight red line linking the two points of the robot 
system coordinates, and a straight blue line linking the two points of the edit view coordinates appears 
in the edit view. 
Also, when you click on the edit view when the Coordinate Conversion dialog is open, you can set 
coordinates to the item which is selected by the radio button by clicking on coordinates in the edit view.  
 

 
 
After setting the coordinates, click the OK button to automatically set the offset values, the conversion 
center point, the rotation angle and the expansion/contraction scale. 
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19.6 Import Function 
With Point Graphic Editor, you can import the following data formats, and use them for graphic editing. 
 
DXF : AutoCAD data format. You can load this data format as an imported 

figure. 
Gerber Data : Plot data format. Combatable with RS-274D/RS-274-X. You can 

load this data as an imported graphic. 
 
 
19.6.1 DXF File/Gerber Data Import Function 
 Overview 
You can convert and load DXF data regulated by AutoDesk Inc., or plot data in the form of Gerber data 
(RS-274D/RS-274-X) to JR C-Points II data.  
Not all DXF/Gerber data is loaded; the coordinate values in DXF data are used as is, and information 
that can be expressed in JR C-Points II data is converted and loaded. 
In addition, only one DXF or Gerber data file can be loaded at the same time. If you import DXF/Gerber 
data when there already is a graphic loaded, the previously loaded data is discarded. 
 
 
 Compatibility 
Below are the compatible items for DXF files and Gerber Data. 
 
 DXF Data 
Compatible Group Code 
 
POINT : Points 
LINE : Lines 
POLYLINE : Line and arc combination information 
LWPOLYLINE : Line and arc combination information 
CIRCLE : Circles 
ARC : Independent arcs 
TRACE : Thick lines (not filled in) 
SOLID : Filled in (not filled in) 
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 Gerber Data 
Straight lines, arcs, and circles 
 
 Operation Procedure 
Select [File] from the menu bar and then select [Import] – [Import DXF File] / [Import Gerber Data File]. 
 
The import settings dialog is displayed. Select the subject file to load, enter the load settings, and click 
the OK button. 
 
The offset dialog is displayed. Specify the offset to set to the file and click the OK button to load the file. 
The offset has initial values entered that fit the loaded image to the border of the work area.  
 

NOTE 
When loading Gerber data, if the specified number of digits cannot be found within the Gerber data 
file, the file is analyzed by 3 digit decimal LZO actions. 
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• Settable Items 
Import File Name : From the file selection dialog, specify the file to import. 
Input File Input : Select whether the import file is uses a mm system or an inch 

system. (This software uses a mm system). 
Revert at Horizontal Axis : Specify whether to invert the horizontal axis when the file is loaded. 
Revert at Vertical Axis : Specify whether to invert the vertical axis when the file is loaded: 
Exchange XY Coordinates 
of Imported File 

: Specify whether to switch the X coordinates and Y coordinates when 
the file is loaded. 

 
 

 
Offset Value   
X : Specify the offset for the X coordinates. 
Y : Specify the offset for the Y coordinates. 
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19.7 Page Settings Dialog 
On the page setting dialog there are settings for the work area etc. of the diagrams being edited. The 
initial settings are automatically set according to the robot model information. These settings are saved 
to the C & T data file. However, these settings cannot be sent to the robot. 
 

 
 
 
Work Area Size   
X (min – max) : This sets the X value’s work area range. Enter values so the 

right box has larger values than the left box.  
Y (mix – max) : This sets the Y value’s work area range. Enter the values so the 

right box has larger values than the left box. 
Positive Left Direction of 
Horizontal Axis 

: Normally the right direction is positive, however, by putting a 
check in this, the left direction becomes positive. 

Positive Upwards 
Direction of Vertical Axis 

: Normally the downwards direction is positive, however, by 
putting a check in this, the upwards direction becomes positive. 
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Space Setting   
Margin Width : This specifies pixel units for the margin width around the work 

area. 
Axis Direction Setting   
Horizontal X Axis : This sets the horizontal axis as the X axis and the vertical axis 

as the Y axis. 
Horizontal Y Axis : This sets the horizontal axis as the Y axis and the vertical axis 

as the X axis. 
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20. CUSTOMIZING DATA 
 

 
20.1 TMC Settings 
TMC settings (Teaching Mode Customizing Data) are customizing data which are not restricted by 
account (other customizing data apart from TMC settings are protected by user accounts). Settings 
can be changed without logging in. 
 
Click [Set T.M.C.] on the menu bar and select the item you want to set. The settings dialog for the 
selected item is displayed. 
Select or enter the item you wish to set from the dialog box and click [OK]. 

 
 
 
20.1.1 Default All Program Common Settings 
Here you can set the default values for All Program Common Settings. 
If you return All Program Common Settings to their default values (by clicking [Data]  [All Program 
Common Settings]  [Restore Default Values]), All Program Common Settings revert to the values set 
here. 
 
 
20.1.2 Set View Order 
Here you can set the view order for [Common Setting Variables], [Condition Setting Variables], and 
[Program Setting Variables] included in the Customizing Data. 
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20.1.3 Set Caption 
Here you can set caption names for the [Common Setting Variables], [Condition Setting Variables], or 
[Program Setting Variables] included in Customizing Data. [Common Data Settings], [Condition Data 
Settings] and [Program Individual Settings] in teaching data are displayed using the captions set here. 
Also, when setting captions for [Application], the caption is displayed in parentheses after the title “JR 
C-Points II” on the title bar. For application specification robots, the caption appears in place of the 
application name. 
 
 
20.1.4 Set Menu YN (Teaching Mode Display Items) 
If you uncheck any of the boxes here and send C&T data of the unchecked settings to the robot, the 
unchecked items are not displayed in the Teaching Mode menu. To return the hidden items, check the 
desired boxes and send the C & T data of the checked settings to the robot. Use this function to hide 
unused items and make the menu easier to read.  
• Point Job Data 
• Additional Function Data 
• PLC Programs 
• All Program Common Settings 
 
 
20.1.5 Job in Teaching Mode 
Use this to set point job data numbers. When you send C & T data containing set number(s) to the 
robot, the following jobs are operable in Teaching Mode: 
• Job on Start of Teaching Mode 
• Job on Emergency in Teaching Mode 
• Job on 0 – 9 Keys (valid at the teaching base screen or when using JOG keys) 
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20.2 Accounts 
You need to set and login into an account when defining or creating customizing data (with the 
exception of T.M.C settings). You can set up to 100 accounts. Once logged in you remain logged in 
until you either log out or close JR C-Points II. Also, you cannot log into multiple accounts at one time. 
Customizing data (with the exception of T.M.C settings) are protected by their accounts (account 
restricted). The level of account accessibility varies according to the type set in the Protect Mode for 
each datum (refer to the table below). 
 
 Access Restriction from Other Accounts 

Protect Mode No Limit Public Protected Private 
Use data      
View data     
Edit data      

 
For further details, refer to “4.1 Types of Accessibility” in the operation manual Functions IV 
(Customizing). 
 
 
20.2.1 Login 
If you want to login using an existing account (login name and security code), click [Account] on the 
menu bar and select [Login] from the pull-down menu. The Login dialog box shown below is displayed.  
Enter the login name and security code (4 – 8 numerical digits) and click [OK]. 
To login using a new account, refer to “20.2.3 Create Account”. 

 

 
NOTE 

• The robot has an account [User] which does not require a security code. This account is useful for 
creating or setting customizing data which does not require protection by an account. 

• There is no way to recover your security code. As such, please make sure you never forget your 
security code. 
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20.2.2 Logout 
To logout, click [Account] on the menu bar and click [Logout] on the pull-down menu.  

 
 
 
20.2.3 Create Account 
To make a new account, click [Account] on the menu bar and click [Make Account] on the pull-down 
menu. The dialog box shown below is displayed. 
Enter the login name and the security code twice and click [OK]. Enter 4 – 8 numerical digits for the 
security code. 

 
 
 
20.2.4 Delete Account 
To delete an account, click [Account] on the menu bar and click [Delete Account] on the pull-down 
menu. If you delete an account, all the customizing data included in that account is also deleted. You 
cannot delete the special preset account [user]. 
 
 
20.2.5 Change Security Code 
Use this to change the security code used for logging into the account.  
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20.2.6 Transfer 
You can transfer all the customizing data from the currently logged in account to any other account. 
Click [Account] on the menu bar and select [Transfer] on the pull-down menu and enter the destination 
account. 
Once you move data, all of the original customizing data in the transfer source account is deleted. 
 
 
20.3 Point Jobs, Additional Functions, and PLC Programs 
Customizing data is protected by its account. You cannot edit customizing data belonging to other 
accounts. Before creating or defining customizing data, first make an account and login. 
 
 
20.3.1 Point Job Data, Additional Function Data, and PLC Programs 
Once you are logged in, you can create and edit the point job data numbers 501 – 1000, additional 
function data numbers 51 – 100 (not including work adjustments), and PLC program numbers 51 – 
100 included in the customizing data (excluding any customizing data which is protected by another 
account). 
 
Methods for creating and editing are the same as for point jobs/additional function data in teaching 
data.  
Click [Data] on the menu bar and select [Point Job], [Additional], or [PLC]. When selecting [Additional], 
please select the additional function data type. A list for the corresponding choice is displayed. 
When you select a number included in customizing data its edit dialog box appears. 
Methods for creating and editing are the same as that for teaching data, however, the owner (login 
name) is displayed in the editing dialog box and it is possible to set Protect Mode. 
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Example: Point Job Data List 

 
 
 
20.4 Global Variables, Keeping Variables, User Functions, and Aliases 
If you create global variables, keeping variables, user functions and aliases while logged in, these are 
created as customizing data and owned by the account logged in at the time of creation. 
The method of creating these is the same as for teaching data, however, the owner (login name) is 
displayed at the top of the editing dialog and it is possible to set Protect Mode. 
 
Example: Global Variable 
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20.5 Setting Variables 
20.5.1 Common Setting Variables 
A common setting variable is a variable that can be set with only one value. Common setting variables 
are declared in Customizing Data and the values are set in the teaching data. You can set the values 
for the defined common setting variables as “Common Setting Data”.  
Typically, settings for a connected device etc., and settings for programs with values that don’t change 
are defined as common setting variables. 
Click [Customize] on the menu bar and select [Common Setting Variables] on the pull-down menu. 
The Common Setting Variables list is displayed. To define a new common setting variable, click on the 
type you want to add and enter an identifier. To edit an existing common setting variable, select the 
variable you want from the list and click [Edit]. The settings dialog box for the selected variable type is 
displayed. Refer to the following pages for explanations regarding each variable type. 
Also, select the data you want and click [Copy] to copy the data and click [Delete] to delete the data. 
You can define up to 100 common setting variables. 

 

 
 
  

List 

Currently selected common setting variable content 
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20.5.2 Condition Setting Variables 
Condition setting variables are variables that can be set with a maximum of 500 values. These are 
declared in the Customizing data and the values are set in the teaching data. Values of defined 
condition setting variables can be set as “Condition Setting Data”. 
Click [Customize] on the menu bar and click [Condition Setting Variables] on the pull-down menu. The 
Condition Setting Variables list is displayed. To define a new one, click on the type you want to add and 
enter an identifier. To edit an existing condition setting variable, select the variable you want from the 
list and click [Edit]. The settings dialog box for the selected item is displayed. Refer to the proceeding 
pages for explanations regarding each variable type. 
Also, select the data you want and click [Copy] to copy the data and click [Delete] to delete the data. 
You can define up to 100 condition setting variables. 
 
 
20.5.3 Program Setting Variables 
Click [Customize] on the menu bar and click [Program Setting Variables] on the pull-down menu. The 
Program Setting Variables list is displayed. To define a new program setting variable, click on the type 
you want to add and enter an identifier. To edit an existing program setting variable, select the variable 
you want from the list and click [Edit]. The settings dialog box for the selected variable type is displayed. 
Refer to the following pages for explanations regarding each variable type.  
Also, select the data you want and click [Copy] to copy the data and click [Delete] to delete the data. 
You can define up to 100 program setting variables. 
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20.5.4 Select Type Setting Variables 

 
 
  

The Select Type Variable Define List 
shown to the right is displayed when 
you click [Add Select Type] or when 
you select a Select Type variable 
and then click [Edit]. 
By default the identifier is set as the 
caption. If you want to set a caption, 
select a language, enter the caption, 
and then click [Register].  
en: English 
ja: Japanese 
de: German 
it: Italian 
es: Spanish 
fr: French 
ko: Korean 
ch: Chinese 
cz: Czech  
vi: Vietnamese 
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For selectable types, you can also set captions for the selectable items. Select the item you want from 
[Select Caption] and click [Edit]. Then enter the caption and click [Register]. 
Also, by default there are two selections, however, you can add selections by clicking [Add]. You can 
set up to 20 selections. 
 
If you open [Common Data Setting] or [Condition Data Setting] in the Teaching Data*, the caption set 
here is displayed (see diagram on the previous page). 
However, the teaching data is displayed in the language set in [Set Application Language]. In the 
example on the previous page, [English] is selected in [Set Application Language]. If other languages 
are selected, the selections are displayed as [S1] and [S2] instead of [busy] and [steady]. 
 
*[Common Data Setting] and [Condition Data Setting] are displayed as the captions set under [Set 
Caption] in the [Set T.M.C.] menu. 
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20.5.5 Number Type Setting Variables 

 
  

 

N
um

eric value range 

The dialog box shown to the right is 
displayed when you click [Add Number 
Type] or when you select a number type 
variable and then click [Edit]. 
By default the identifier is set as the 
caption. If you have a caption you want 
to set, select a language, enter the 
caption, and then click [Register]. 
 
en: English 
ja: Japanese 
de: German 
it: Italian 
es: Spanish 
fr: French 
ko: Korean 
ch: Chinese 
cz: Czech  
vi: Vietnamese 
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Enter the numeric value range and select the unit you are using. 
Default Value: The values set as defaults 
Minimum Value: The minimum value you can enter 
Maximum Value: The maximum value you can enter 
Decimal Figure: The decimal place to where a value is rounded 
(If [Decimal Figure] is set to [0.1], values entered as [0.27] or [0.33] are rounded to [0.3])  

 
If you open [Common Data Setting] or [Condition Data Setting] of the teaching data*, the caption set 
here is displayed (see diagram on the previous page). 
 
*[Common Data Setting] and [Condition Data Setting] are displayed as captions set under [Set 
Caption] in the [Set T.M.C.] menu. 

 
 
20.5.6 Point Type Setting Variables 

 
The dialog box shown above is displayed when you click [Add Point Type] or when you select a point 
type variable and then click [Edit]. 
By default the identifier is set as the caption. If you wish to set a caption, select a language, enter the 
caption, and then click [Register]. 
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en: English es: Spanish ch: Chinese (simplified) 
ja: Japanese fr: French cz: Czech  
de: German ko: Korean vi: Vietnamese 
it: Italian   

 
Click [Add] to add a new point to the end of an array of points. Click [Insert] to add a new point in front 
of the point where the cursor is currently placed. Click [Delete] to delete the point where the cursor is 
currently placed. 
 
Enter the point data you wish to set. 
If you wish to register the point coordinates in JOG Mode, place the cursor on the point you wish to 

register and click the JOG icon (  ). The JOG dialog box is displayed. 
 
 
20.5.7 PTP Condition Type Setting Variables 

 
You can now edit the number for the PTP condition specified in [PTP Condition Number] in the 
teaching data [Common Data Settings]. You can activate a defined or edited PTP Condition by setting 
it to a point. 
  

The dialog box shown to the right is displayed 
when you click [Add PTP Condition Type] or 
when you select a PTP condition type variable 
and then click [Edit]. 
By default the identifier is set as the caption. If 
there is a caption you wish to set, select a 
language, enter the caption, and then click 
[Register]. 
 
en: English 
ja: Japanese 
de: German 
it: Italian 
es: Spanish 
fr: French 
ko: Korean 
ch: Chinese 
cz: Czech 
vi: Vietnamese 
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20.6 Point Types 
Click [Customize] on the menu bar and click [Point Type Setting] on the pull-down menu. A point type 
list is displayed. Click [Add] and enter an identifier to define a new point type. To edit an existing point 
type, select the point type you want from the list and click [Edit]. The Edit dialog box is displayed. 
Also, select the data you want from the list and click [Copy] to copy the data and click [Delete] to delete 
the data. 
You can define up to 100 point types. 

 
 

NOTE 
To change the base point type, select the point type you want from the list and click [Change Base 
Type ID]. You cannot change the base point type from the edit dialog box. 
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Select and set the “Job” type you want to set to the point job data you want. Simply set the point type 
during teaching and the set point job data is executed when the program is run. 
 
To set a point setting variable to a point type, click the type you want to add and enter an identifier. 
Once you have set a variable to a point, simply set the point type at the time of teaching, and the 
variable (default values) point is registered to the point. 
 

NOTE 
During teaching, when you set point job data to a user-defined point type, if the same point job 
settings are included in the point type they are not executed. For example, if [Job before Moving] is 
set as the user-defined point type, the “Job Before Moving” job data registered to the point type is 
not performed.  
In these situations, use the callBase command for point job data set to the user-defined point, the 
point job etc., attached to the type can be called up as a subroutine. 

  

The edit dialog box shown to 
the right is displayed when you 
click Add and then select a base 
point type or when you click 
[Edit]. 
By default the identifier is set as 
the caption. If you wish to set a 
caption, select a language, 
enter the caption, and then click 
[Register]. 
 

en: English 

ja: Japanese 

de: German 

it: Italian 

es: Spanish 

fr: French 

ko: Korean 

ch: Chinese 

cz: Czech  
vi: Vietnamese 
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21. PC CUSTOMIZE 
 

 
You can customize the JR C-Points II functions. This is different from the robot’s customizing data and 
content customized here is not applied to the robot. These settings are only applied to JR C-Points II. 
 
21.1 Point Type of New Input 
Set the point type for the point that is set when you push the point adding buttons on the tool bar or 
when you add a graphic in Point Graphic Editor.  
From [PC Customize] on the menu bar, select [Point Type of New Input].  
Set the base point type for every point type which is entered here and click the [OK] button. 

 

 
NOTE 

• When you are adding a point, if the point type definition set here does not exist, the point type which 
holds the same base point type has another point type added to it. 

• PC Customize information is saved as JR C-Points II information and is not included in the C & T 
data file. Accordingly, when you modify the PC Customize settings, even if you open a previous C & 
T data file and startup JR C-Points II, the list content will not revert to its previous state. 
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22. TRANSFERRING ROBOT SYSTEM 
SOFTWARE 

 

 
This robot is controlled by built-in robot system software. To upgrade the robot system software, follow 
the instructions below.  
Also, if you mistakenly turn OFF the robot during an update or the update failed causing the robot to 
malfunction, you can also use the following instructions to restore the robot system software. 
 
 JR3000 Series: JR3_SysProgram_V.+++_***.jsy 
(“+++” indicates the version number. “***” varies according to robot specifications.) 
 
1. Turn ON the robot and place the operation manual CD-ROM in the drive. 
2. Start JR C-Points II and select [Send Robot System Software] from the [Robot] pull-down menu on 

the menu bar. The dialog box shown below is displayed. 

 
3. If updating, select [Version Update] as the Transmission Mode. If restoring the system software, 

select [Recovery] as the Transmission Mode. (The robot IP address needed for recovery is 
“192.168.200.180”). 

4. Click [Open], specify the drive where the Operation Manual CD is placed, then select the robot 
system software file and click [Open]. The selected file name is displayed. Click [Send] and the 
robot system software starts sending. 

5. After the transmission, turn the robot OFF and then ON again.  
 

 
  

Attention 
Never turn OFF the robot or PC while sending the robot system 
software. Otherwise, the robot may not be able to start up. 
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23. ROBOT DATA BACKUP 
 

 
The robot (data) storage area is partitioned as shown by the diagram below. All of the storage area 
partitions including the robot system software storage partition are subject to backup and data 
restoration operations. 
 

 

 
23.1 Data Backup 
The robot system software, C&T data, individual configuration information and model setting files are 
read and saved as a file. If you do not specify an extension name, the file is saved with the extension 
“JRB.” 
Select [Backup Robot Data] from the [Robot] pull-down menu to display the dialog below.  
 
Click the file icon and specify the name of the backup file and the location where you want to save it. 
You can also specify an existing file. Click [Backup] and the backup starts.  
 

 
  

Robot System 
Software 

Individual  
Config. Info. 

C & T Data 

Storage Area 

 

Model 
Setting Files 

Open Existing File 
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23.2 Restore Robot Data 
This restores the data saved in [Robot Data Backup] to the robot. 
Executing robot data restoration deletes all of the data in the robot (robot system software, C&T data, 
individual configuration information and model setting files) and overwrites it with the backup file. 
 
Click [Robot] on the menu bar and select [Restore Robot Data] from the pull-down menu. The dialog 
below is displayed. 
Click the [Open File] icon, specify the backup file and click [Restore]. 
 

 

 

 

Individual configuration information varies for each individual unit 
even if they are the same model. Do not use backup data with a 
different robot. The robot cannot function normally with backup 
data from a different robot. 

Caution 
 

Individual configuration information varies for each individual unit 
even if they are the same model. Do not use backup data with a 
different robot. The robot cannot function normally with backup 
data from a different robot. 

Caution 
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24. CONVERTING JR2000/JR2000N DATA TO 
JR3000 DATA 

 

 
To use JR2000/JR2000N teaching data as JR3000 C&T data, it is necessary to convert the data. The 
following three steps are needed to convert the data. 
 
1. Use JR Points (JR2000 option) and/or JR C-Points (JR2000N option) to send the data to the PC. 
2. Open the received data in 1 above using JR C-Points II*. 
3. Send the data from the PC to the JR3000 using JR C-Points II*.  
 

 
*In place of JR C-Points II (optional), JR C-Points II Limited Edition (included in the operation manual 
CD) can also be used to convert data. 

 
NOTE 
It is possible to connect one PC to both robots; JR2000/JR2000N Series and JR3000 Series at the 
same time. You can also connect a PC to the JR2000/JR2000N Series robot to receive data, then 
disconnect the JR2000/JR2000N and connect the JR3000 Series robot to the PC. 
(To convert data using a PC, JR-Points and/or JR C-Points and JR C-Points II must be installed on 
the PC.) 

 

 

  

 

Teaching Data 

Connect Connect 

JR2000/JR2000N 
JR2203N Example 

PC (JR-Points/ 
JR C-Points) 

PC (JR C-Points II) JR3000 
JR3203N-AC Example 

Caution Be sure to turn OFF the robot before removing or connecting the 
cable. Failure to do so may cause unit malfunction or data loss. 
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Please carry out the following operations: 
(This is done using a PC with JR-Points and/or JR C-Points and JR C-Points II installed and connected 
to the JR2000/JR2000N and JR3000 Series robots.) 
 
1. Turn ON the robot and the PC. If the robot is in Run Mode, make sure it is waiting to start, and for 

other modes, have the robot at the base screen.  
 
2. When transferring from the PC to the robot, startup JR-Points for the JR2000 Series and JR 

C-Points for the JR2000N Series, and set the port to match the COM port connected to the 
JR2000/JR2000N Series robot. 

 Operation Procedure 
[Robot] Menu  [COM Status] 

 
3. Transfer the teaching data from the JR2000/JR2000N Series robot. 
 Operation Procedure 

[Robot] Menu  [Receive C&T Data] 
 
4. Name the data and save it. For JR-Points, the file is saved an “.rp*” extension. For JR C-Points, 

the file is saved as an “.cp*” extension (“*” varies depending on the specifications). 
 Operation Procedure 

[File] Menu  [Save As] 
 
5. Exit JR-Points or JR C-Points and startup JR C-Points II. 
 
6. Set the destination JR3000 Series robot for sending data to in the Ethernet Settings. 
 Operation Procedure 

[Robot] Menu  [Ethernet Settings] 
 
7. Select [Open] from the [File] pull-down menu and change [File Type] to [JR Points File (*.rp*)] for 

JR2000 Series and [JR C-Points File (*.cp*)] for JR2000N Series and open the data file from the 
JR2000/JR2000N Series robot. 
(“*” varies depending on the specifications.) 

 Operation Procedure 
[File] Menu  [Open] 
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8. Transfer the data to the JR3000 Series robot.  
When data is transferred from the PC to the robot, any data stored in the robot is deleted, so take 
caution. 

 Operation Procedure 
[Robot] Menu  [Send C&T Data] 

 
NOTE 

• For the JR-Points operating environment etc., refer to the JR-Points operation manual. 
• For the JR C-Points operating environment etc., refer to the JR C-Points operation manual. 
 
 Precautions when converting from JR-Points to JR C-Points II 
• The sysFlag numbers for point jobs, execute conditions, PLC programs etc., do not change when 

they are converted over from JR-Points, however, contents of some items have changed with JR 
C-Points II. Please confirm after converting over to JR C-Points II. 

 
 Precautions when converting from JR C-Points to JR C-Points II 
• Point job numbers 101 – 200 for JR C-Points are, depending on the protection mode, converted as 

follows:  
The point job numbers of items in [No Limit] and [Public] protection modes do not change. For this 
reason, these items can be run as they are. 
Items in [Protected] and [Private] protection modes are converted with +400 added to their point job 
number to protect the defined content. For this reason, these items cannot be run as they are. 
Please amend this data. 

• With JR C-Points II, TPIF (Port 4) has been removed from the COM ports. For this reason, items 
which are specified to TPIF (Port 4) in JR C-Points are converted to COM 1. However, point jobs 
are not converted, so please amend this data. 

• The various display order of T.M.C settings are not converted. 
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25. JCS FILE FORMAT 
 

 
JCS files are a file format that holds recorded point row data in a CSV format. You can import JCS files 
into JR C-Points II. 
The JCS file format is as follows: 
 
25.1 Format 
 Header Line 
Specify “JR Points_CSV” is in the first line. 
This line is used so that the file specified by JR C-Points II is identified as a JCS file. 
 
 Data Lines 
Specify the second line onwards as data lines. 
Separate the items using commas, as follows: 
Point type code, X coordinates, Y coordinates, Z coordinates, R coordinates, MT1 coordinates, MT2 
coordinates. 
 

NOTE 
The MT1 coordinates and MT2 coordinates can be omitted. 

 
Details of each item are as follows: 

Item Content 
Point type code Specify the point type code (described later). 
X coordinates (*) Specify the X coordinates -2000 – 2000. Smaller decimals are rounded to 

the 4th digit. 
Y coordinates (*) Specify the Y coordinates -2000 – 2000. Smaller decimals are rounded to 

the 4th digit. 
Z coordinates (*) Specify the Z coordinates -999.999 – 999.999. Smaller decimals are 

rounded to the 4th digit. 
R coordinates Specify the R coordinates -720 – 720. The units which can be used are 

degrees only. Smaller decimals are rounded to the 3rd digit. 
MT1 coordinates (*) Specify the MT1 synchronized axis coordinates.  

Specify the coordinates -9999.999 – 9999.999. Smaller decimals are 
rounded to the 4th digit. 

MT2 coordinates (*) Specify the MT2 synchronized axis coordinates.  
Specify the coordinates -9999.999 – 9999.999. Smaller decimals are 
rounded to the 4th digit. 

 
NOTE 
There is no unit specification for JCS files. When importing the JCS file into JR C-Points II, specify 
the unit of length (millimeters/inches).   
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Point type codes include the codes below. 
Depending on the application specifications you are using, some point types are set automatically for 
the dedicated application point types often used. 

Point Type Code Point Type 
PTP PTP point 
CP_S CP start point 
CP_P CP passing point 
CP_E CP end point 
ARC CP arc point 
CP_CS Circle start point 
CP_CC Circle center point 
ZA_S (*) Rectangle spiral start point 
RA_S (*) Zigzag start point 
AREA_E (*) Rectangle end point 
CA_S (*) Spiral start point 
CA_P1 (*) Circumference of spiral area 1 
CA_P2 (*) Circumference of spiral area 2 

* You can only use these point types with Dispensing Specifications. 
 
 
25.2 JCS File Data Example 
A JCS file data example is as follows: 

 
 
If you import the above JCS file to JR C-Points II, the data is imported as follows: 
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26. HELP MENU 
 

 
26.1 About... 
This displays the version information dialog. 
 
 
26.2 Help 
This displays information and explanations regarding the use of JR C-Points II. 
  

161 



PC Operation Desktop Robot JR3000 

27. APPENDIX 
 

 
27.1 Homing Operation Methods 

27.1.1 Start & Completion 
The item explained here is for robots equipped with auxiliary axis functions. 
 
 Timing Chart 

 
 
The error in the table below can occur if there is a problem with the homing operation. 
Error Details 
Homing Move Timeout 
Error 

The time from when the “start homing” signal came ON until the “finish 
homing” signal turns ON exceeds the homing operation parameter 
[Timeout]. 
(The time from 1 until 2 exceeded the setting [Timeout]) 

 
  

IO-MT 
Output 

Device Homing Operation Device Operation 

ON 
OFF Start Homing 

IO-MT 
Input 

ON 
OFF Finish Homing 

Output Pulse  

Offset Distance 

1 

2 

10ms or more 
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27.1.2 Sensor Position Type 
This item explained here is for robots equipped with auxiliary axis functions. 
 
 Operation Image 
 

 
 
At the start of the homing operation, if the axes are already in the area where the sensor is blocked, the 
axes move at homing operation speed 1 in the positive direction until they exceed the area where the 
sensor is blocked, and then continue to move in the positive direction by the exact offset distance. 
After this, the operation in the above diagram starts. 
 
 Timing Chart 
 

 

 
The errors in the table below can occur if there is a problem with the homing operation. 
Error Details 
Homing Move Timeout 
Error 

The elapsed time from the start of the homing operation exceeded the 
homing operation parameter [Timeout]. 

Homing Operation 
Sensor Error 

1. Movement started from outside of the area where the sensor is 
blocked and even though the axes moved the distance specified in the 
homing operation parameter [Valid Length], the axes did not enter the 
area where the sensor is blocked. 

2. Movement started from inside the area where the sensor is blocked 
and even though the axes moved the distance specified in the homing 
operation parameter [Valid Length], the axes did not exceed the area 
where the sensor is blocked. 

  

 
Homing Operation Speed 1 

Reverse Distance Area where the 
Sensor is Blocked 

Homing Operation 
Start Position 

Homing Operation 
Speed 2 

Homing Operation 
Speed 3 

Offset Distance 

Image of the movement made by the axes in 
the area the sensor is blocked. 

Reverse Distance 

IO-MT 
Input 

ON 
OFF Homing Sensor 

Positive Direction Pulse 

Negative Direction Pulse Speed 1 

Speed 3 

Offset Distance 

asdfsadf Speed 2 
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27.1.3 Timing Signal Type 
This item explained here is for robots equipped with auxiliary axis functions. 
 
 Operation Image 

 
At the start of the homing operation, if the axes are already in the area where the sensor is blocked, the 
axes move at homing operation speed 1 in the positive direction until the sensor is released, and then 
continue to move in the positive direction by the exact offset distance. After this, the operation in the 
diagram above starts. 
 
The “timing signal result” is the execution result of the homing operation. The timing signal varies 
depending on the position relationship between the position which is output and the position detected 
by the sensor. “Timing signal result” can be confirmed by using the Configuration Check Mode. 
 
 
 Timing Chart 

 
  

 
Homing Operation Speed 1 

Reverse Distance Area Where the 
Sensor is Blocked 

Homing Operation 
Start Position 

Homing Operation 
Speed 2 

Homing Operation 
Speed 3 

Offset Distance 

Timing Signal 
ON 

Timing Signal Length (set value) 

Timing Signal Result 
(execution result) 

Reverse Distance 

IO-MT 
Input ON 

OFF Homing Sensor 

Positive Direction 
Pulse 

Negative Direction 
Pulse 

Speed 1 

速度   2 速度   2 

Timing Signal Length 

ON 
OFF Timing Signal 

Speed 3 

Offset Distance 

Speed 2 Speed 2 
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The errors in the table below can occur if there is a problem with the homing operation. 
Error Details 
Homing Move Timeout 
Error 

The elapsed time from the start of the homing operation exceeded the 
homing operation parameter [Timeout]. 

Homing Operation 
Sensor Error 

Movement started from outside of the area where the sensor is blocked 
and even though the axes moved the distance specified in the homing 
operation parameter [Valid Length], the axes did not enter the area where 
the sensor is blocked. 
Movement started from inside the area where the sensor is blocked and 
even though the axes moved the distance specified in the homing 
operation parameter [Valid Length], the axes did not exceed the area 
where the sensor is blocked. 

Homing Move Timing 
Signal Error 

Even though the axes moved the exact distance specified in the homing 
operation parameter [Timing Signal Length], the timing signal did not come 
ON. 
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 Homing Operation Precautions for Devices with Rotational Motions 
The direction of operation for homing operations performed via the “Sensor Position Type” or “Timing 
Signal Type” are determined depending on the sensor ON/OFF status, regardless of the position 
coordinate values at the start of the operation.  
For controlled devices with rotational motions such as for a dispense syringe etc., you need to take 
note of the rotation. 
For example, if using a semicircular shield to block the sensor, a homing operation from 200[deg] 
position coordinates and a homing operation from -160[deg] position coordinates start the homing 
operation in the same direction. 
 

 
 
In addition, homing operations are performed in accordance to the sensor switching ON/OFF even if 
the total angle exceeds 360[deg] due to multiple rotations. Devices will not make return operations 
according to the sum of multiple rotations. 
 
 

0[deg] 

200[deg] 

0[deg] 

0[deg] 

-160[deg] 

Shield Sensor 

0[deg] 

A program run which moves the device 
to position coordinates of 200[deg]. 

A program run which moves the device 
to position coordinates of -160[deg]. Homing Operation 

Complete 

200[deg] Position 
Coordinates 

-160[deg] Position 
Coordinates 

Homing operation  
starts 

Homing operation  
starts 

Homing Operation 
Starts 

Homing Operation 
Completes 

Direction the 
movement starts 
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